Supplement:

Partnerships (1065)
Copyright

The 2016 Drake Tax Manual Supplement: Partnerships, Drake Tax Software, and any other related materials are copyrighted material. All rights are reserved by Drake Enterprises, LTD, including all ownership rights. This document, associated software, and related material are the property of Drake Enterprises, LTD.

Drake Enterprises, LTD, hereby authorizes you to download, display, print, and reproduce the material in this document in an unaltered form only for your personal, non-commercial use or for non-commercial use within your organization. Copyright, trademark, and other proprietary notices may not be removed.

© 2016 Drake Enterprises, LTD. All rights reserved.

While every attempt has been made to produce an accurate and complete manual, there is no warranty, expressed or implied, to that effect. Drake Enterprises, LTD, assumes no liability for damages or claims resulting from the use of the information contained herein.

Trademarks

The Drake Software Logo and Drake Tax are registered trademarks of Drake Enterprises, LTD.

Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft Corporation in the United States and other countries.

Other product names mentioned in this manual may be trademarks or registered trademarks of their respective companies.
# Table of Contents

What’s New in Drake for Partnership Returns ................................................................. 9  
Security Screen in the Business Packages ................................................................. 9  
Greater K-1 Export Flexibility ...................................................................................... 10  
Sorting Schedules K-1 ................................................................................................. 10  
Oil and Gas Depletion Worksheet .............................................................................. 11  
Foreign Tab .................................................................................................................. 11  
Special Allocations Enhancements ........................................................................... 11  
Practice Management Tools ....................................................................................... 12  
Updating a Prior-Year Return in Drake Tax ............................................................... 12  
Header Information ..................................................................................................... 12  
Name and Address ....................................................................................................... 12  
Tax Year ....................................................................................................................... 12  
Boxes A through J ......................................................................................................... 14  
Income and Deductions ............................................................................................. 14  
Gross Receipts ............................................................................................................ 14  
Cost of Goods Sold (Form 1125-A) .......................................................................... 15  
Ordinary Income (Loss) .............................................................................................. 15  
Net Farm Profit (Loss) ................................................................................................. 16  
Net Gain (Loss) ........................................................................................................... 16  
Other Income (Loss) .................................................................................................... 16  
Compensation and Wages ......................................................................................... 16  
Guaranteed Payments and Partner Health Insurance ................................................. 17  
Repairs and Maintenance ............................................................................................ 18  
Bad Debts ...................................................................................................................... 18  
Rents .............................................................................................................................. 18  
Taxes and Licenses ....................................................................................................... 18  
Interest .......................................................................................................................... 18  
Depreciation ................................................................................................................ 19  
Depletion ....................................................................................................................... 21  
Retirement Plans ......................................................................................................... 21  
Employee Benefit Plans ............................................................................................. 21  
Other Deductions ........................................................................................................ 22  
Filing an Extension ....................................................................................................... 22  
Signing the Return ...................................................................................................... 23  
Amending a Return ..................................................................................................... 24  
TEFRA and Filing Eligibility ....................................................................................... 24  
Additional Information ............................................................................................... 24  
Schedule B .................................................................................................................... 24  
State-specific Information ........................................................................................... 26  
Other Information and Overrides ............................................................................. 28  
Schedule K (Partners’ Distributive Share Items) .......................................................... 29  
Screens K and KFT ....................................................................................................... 29  
Multiple Foreign Transactions .................................................................................... 32  
Business Activities Statement ..................................................................................... 32
EF “ACK” Page ................................................................. 73

Appendix A: Trial Balance Import ............................................... A-1

Index ..................................................................................... lxxvii
This page intentionally left blank.
Partnerships (1065)

The basics of data entry for a partnership (1065) return are the same as for the 1040. Navigation through data entry, field- and screen-level help, and keyboard shortcuts all function as they do in the 1040 program. See the 2016 Drake Tax User’s Manual for the basics of using the program. (The manual is available on the installation CD and on the Drake Support website: Support.DrakeSoftware.com > Training Tools > Manuals.)

What’s New in Drake for Partnership Returns

Drake programs its tax software according to the latest IRS rules and regulations. The 2016 program reflects all changes to credits and deductions, including discontinuations. For details on new regulations for 2016, see the IRS instructions for Form 1065.

Security Screen in the Business Packages

Drake Tax has added a new Filing Security Information screen (SEC) to the Partnership package (Figure 1).

![Filing Security Information screen](image)

Figure 1: The new Filing Security Information screen (SEC)
The information entered on the screen is transmitted when the tax return is e-filed. Completing this screen for federal returns is strictly optional for 2016; however, certain states will begin requiring this information in the near future.

Screen (SEC) is accessible through a link on screen 1 or from the Data Entry Menu.

**Greater K-1 Export Flexibility**

The K-1 Export feature can now export K-1 data from the Partnership package to any of the packages in Drake Tax.

In addition, the K1 “source” screens (K1P) has been enhanced with an Additional Entries tab. This new tab offers 40 more fields for entering, exporting, or importing additional K-1 items. (See “K-1 Export” on page 36 for details.)

**Sorting Schedules K-1**

For convenience when dealing with partnerships that have a large number of partners, you can sort the list of Schedules K-1 by recipient’s name, ID number, ownership percentage, or by the new Control number (red circle in Figure 2).

![Figure 2: Control number to use for sorting](image)

The default sort order (as seen in View mode) is determined by the order in which the partners are entered in the program. To select a new sort order, go to the PRNT screen (available through the General or Miscellaneous tabs of the Data Entry Menu) and, from the Sort K1s by drop list, choose:

- **Control** – Sort by the Control number entered on screen K1 (Figure 2)
- **ID** – Sort numerically based on SSN or EIN of the partner
- **Name** – Sort based on last name of individual partner, on first name of a business partner
- **Shares** – Sort by the partner’s ownership percentage

**IMPORTANT**

Drake Tax does not automatically “increment” the control number. You have to enter a unique number on each partner’s K1 screen.

The Rounding Partner (as selected on the K1 screen; see check box in Figure 2) no longer is automatically sent to the end of whatever sort order you’re using. For details, see “Rounding Partner” on page 34.
Oil and Gas Depletion Worksheet

The new Oil and Gas Depletion Worksheet calculates oil and gas depletion and gives your clients the best possible deduction.

See “Oil and Gas Depletion Worksheet” on page 32 for more information.

Foreign Tab

Use screens on the new Foreign tab of the Data Entry Menu for entering data on foreign financial accounts, for filing FinCEN Form 114, Report of Foreign Bank and Financial Accounts, and Form 8804, Annual Return for Partnership Withholding Tax allocable to foreign partners.

Screen 8813, used for completing Form 8813, Partnership Withholding Tax Payment Voucher, allows you to enter amounts paid by the partnership in the prior year on foreign tax withheld and to produce vouchers for making 2017 quarterly payments. The filing and mailing instructions are listed on screen 8813.

For more on completing FinCEN Form 114, see “Foreign Financial Accounts” on page 261 of the 2016 Drake Tax User’s Manual.

Special Allocations Enhancements

Last year, Drake Tax introduced the SA (Special Allocations) screens that you could use to override the allocation any of the items on screens K, M1, or M2 for any or all of the listed partners.

This year, when you click an SA link from screens K, M1, or M2 to make a special allocation, and enter an amount or percentage on that SA screen, the screen link on the original K, M1, or M2 screen changes color (Figure 3), making it easier to find those items that have been overridden.

Figure 3: The SA links change color to indicate entries were made

The “Other adjustments” field of Section L of the Schedules K-1 will be recalculated based on the overrides entered on the SA screen to reconcile the ending capital.

For more on using the Special Allocation (SA) screens, see “Special Allocations” on page 30.

For more on the “Other” fields of screen M1, see ““Other” Adjustments” on page 45.
Practice Management Tools

For details on additions and enhancements to Drake’s practice management tools—such as the new password requirements and other security enhancements, the new data entry toolbar, changes to Drake Documents (formerly DDM)—see Chapter 1 of the 2016 Drake Tax User’s Manual.

Updating a Prior-Year Return in Drake Tax

If you prepared the tax return in Drake Tax last year, you can update the return for the current year in either of three ways:

- **As a single return** (updated one at a time) using Last Year Data > Update Clients 2015 to 2016 (recommended)
- **When you open the return for the first time in the 2016 program and are prompted to update it**
- **With all other returns in the program using Last Year Data > Update Clients 2015 to 2016 (not recommended)**

When you update a 1065 return that was marked as “final” the previous year, the program informs you that the return was marked final before prompting you to proceed.

Header Information

Screen 1 contains fields for the general information that is printed in the top section of page 1 of Form 1065.

Name and Address

Use screen 1 to complete the partnership name and address section of Form 1065. For state purposes only, if the partnership has an alternate address (such as a P.O. box), you can enter it in the Address Line 2 field at the bottom of screen 2. (Access screen 2 from the States tab of the Data Entry Menu, or enter 2 in the selector field and press ENTER.)

Tax Year

The program uses the calendar year as the default period for all partnership returns. No date entries are required on screen 1 for a December 31 tax year-end.

**NOTE**

The program adjusts calculations for depreciation and for gains and losses on sales of assets based on the entity’s tax year.

For information on filing with a 52-53–week year, see “Electing a 52-53–Week Year (Initial Return)” on page 57.

**Fiscal and Calendar Years**

If the partnership uses a fiscal year (where the year begins in the current calendar year and ends in the next), specify the beginning and ending dates in the If not a calendar year section of screen 1.
For information on electing a 52-53-week tax year, see “Electing a 52-53–Week Year (Initial Return)” on page 57.

A partnership may have a short-year return if changing accounting periods with IRS approval (Form 3115), if this is its first or last year in business and the tax year is not a full year, or if the partnership is facing a technical termination.

A technical termination occurs when there has been a sale or exchange of 50% or more of the interests in partnership capital and profits within a 12-month period. On screen 1 in Drake, mark the Technical termination box and either Initial Return or Final Return as applicable. A final technical termination return must be filed prior to the new, initial technical termination return. See article 10062 in the Drake Software Knowledge Base for more information on technical terminations.

Short-year return election information and 52-53-week tax year information is entered on the Year screen, available on the Miscellaneous tab of the Data Entry Menu or from a Year link on screen 1.

To enter short-year information:

1. Enter short-year dates on screen 1 in the Fiscal year beginning and Fiscal year ending fields, even if the firm uses the calendar year for full-year returns. (These dates will appear on the top of the federal form.)
2. Click the Year link (Figure 4) to open the Year screen.

3. On the Year screen, make your short-year selection from the Other short-year reason drop list. Type an explanation in the Explanation text box. (Your explanation will be displayed at the top of the first page of the tax return.)
4. If you selected “General Explanation” from the Other short-year reason drop list, type details on the reasons for filing a short-year return in the Explanation text box.

NOTE

A technical termination occurs when there has been a sale or exchange of 50% or more of the interests in partnership capital and profits within a 12-month period. On screen 1 in Drake, mark the Technical termination box and either Initial Return or Final Return as applicable. A final technical termination return must be filed prior to the new, initial technical termination return. See article 10062 in the Drake Software Knowledge Base for more information on technical terminations.
For information on making elections through the \textbf{ELEC} screen, see “Elections” on page 52.

For more extensive details on entering short-year return information into Drake Tax, click inside the \textbf{Explanation} text pane of the \textbf{YEAR} screen and press F1 to see the help.

The program may not correctly calculate depreciation, gains, or losses for a short-year return. Depreciation for a short-year return can be manually entered on screen 4562 or screens 6, 7, 8, and 9. For more information on short-year returns, see IRS Pub 4163.

\section*{Boxes A through J}

Enter most information for boxes A through J (top of Form 1065) on screen 1. Note that boxes D (Employer identification number), F (Total assets), and J (Schedule C and M-3 attached) are completed automatically based on information entered elsewhere in the program. Other boxes are:

- Box A — Principal business activity
- Box B — Principal product or service
- Box C — Business code number (Press CTRL+SHIFT+S to search activity codes)
- Box E — Date business started
- Item G — Initial, final, or amended return; address or name change; technical termination
- Item H — Accounting method (Select \textbf{Cash}, \textbf{Accrual}, or \textbf{Other}; if \textbf{Other}, enter a description of the method used.)
- Item I — Number of K-1 forms attached (Completed automatically based on the number of \textbf{K1} screens filled out. Use screen 1 to override this number.)

\section*{Income and Deductions}

Enter income and deductions on the \textbf{INC} (Income) and \textbf{DED} (Deductions) screens. \textbf{INC} screen amounts flow to Form 1065, page 1, lines 1a to 7. (Also see “Other Income (Loss)” on page 16.) \textbf{DED} screen amounts flow to Form 1065, page 1, lines 9 through 20. “Other income” and “Other deductions” data is shown on attached statement worksheets in View mode of the return.

\section*{Gross Receipts}

Enter gross receipts or sales and returns and allowances on the \textbf{INC} screen.

\section*{NOTE}

The IRS does not require a detail worksheet (CTRL+W) for gross receipts; therefore, if you are using the trial balance import feature, do not include a detail worksheet for this line—or for any other line that does not require a detail worksheet.
Cost of Goods Sold (Form 1125-A)

For cost of goods sold entries, complete screen A (Form 1125-A, Cost of Goods Sold).

**NOTE**

On screen A, items 9a through 9f are direct-entry fields and follow the format of IRS Form 1125-A. For more information on completing these fields, press F1 or consult the IRS instructions.

**Inventory**

Inventory amounts entered on lines 1 and 7 of screen A automatically flow to Schedule L, line 3, “Inventories.” Note that the inventory fields on screen L (Schedule L - Balance Sheet - Assets) are overrides; entries there override inventory data from screen A.

**Line 5, Other Costs**

Line 5 of Form 1125-A is designated for any applicable costs not entered on the previous lines. In Drake Tax, two fields on screen A are provided for line 5: one for other costs including depreciation and one for other costs excluding depreciation. (Figure 5).

![Figure 5: Other costs and depreciation](image)

In the Other costs - depreciation field, enter any depreciation that relates to the cost of goods sold (unless the amount is flowing from the 4562 Detail screen with COGS selected from the For drop list). Note that this field on screen A is an override field; an entry here overrides the calculations from the 4562 screen and automatically adjusts the total depreciation that flows to page 1 of Form 1065. For Other costs - excluding depreciation, use a detail worksheet (CTRL+W). The depreciation amount is included on the statement for other costs and should not be included in the Other Costs detail worksheet.

**NOTE**

Line 16b on the DED screen is an adjustment field for depreciation from Form 4562 not entered on screen A.

**Importing Trial Balance to Sch A**

If using the trial balance import feature (see “Importing Trial Balance Information” on page 62), enter depreciation amounts directly into the appropriate fields on the trial balance worksheet, not in data entry. When the trial balance is imported, the COGS depreciation expense amount flows directly to the appropriate line of Form 1125-A and is calculated accordingly. For more on depreciation and trial balance import, see “Depreciation” on page 69.

**Ordinary Income (Loss)**

Ordinary income or loss from other partnerships, estates, and trusts (line 4 of Form 1065) flows from either screen K1P (Schedule K-1 from another partnership) or screen K1F (Schedule K-1 from a fiduciary).
Net Farm Profit (Loss)

*Screen Code: F*

The partnership’s net farm profit or loss (line 5 of Form 1065) flows from information entered on screen **F** (*Farm Income and Expense*). Farm profit or loss from other partnerships, estates, or trusts appears on line 4 of the return. To enter this information, from the **INC** screen, click the links on line 4 to screen **K1P** or screen **K1F**. Enter the farm profit or loss from other partnerships, estates, or trusts on line 1 of screen **K1P** or line 6 of screen **K1F**.

For information on farming partnerships with a corporation partner, see Pub. 225, *Farmer’s Tax Guide*.

Net Gain (Loss)

The amount on line 6 (“Net gain (loss) from Form 4797, Part II, line 17”) of Form 1065 flows from Form 4797. Amounts can also flow from screen **4562**, but only if that screen shows assets sold and property type.

Other Income (Loss)

Use the **INC** screen to enter amounts for the “Other income” line of the main form. Specific **INC** screen entries are displayed on attached statements in View mode of the return.

Amounts from the following screens also flow to line 7:

- **Screen 6478** — Form 6478, Biofuel Producer Credit
- **Screen 8864** — Form 8864, Biodiesel Fuels and Low Sulfur Diesel Fuel Production Credits

Additional fields on the **INC** screen include:

- Interest income on receivables
- Recoveries of bad debts deducted in earlier years
- Section 481 adjustments
- State tax refund (cash basis)
- Taxable income from insurance proceeds

Enter additional sources of income not shown in the **Other income (itemize)** field. Begin typing in that field and a detail worksheet (CTRL+W) is opened with fields for descriptions and amounts.

To enter other income (loss) from a partnership, estate, or trust, use the **K1P** or **K1F** screen (click the links on line 4 of the **INC** screen).

Compensation and Wages

Use line 9 of the **DED** screen to enter wages and salaries paid. Do not include guaranteed payments to partners or salaries or wages reported elsewhere in the return, such as the amounts included in COGS, elective contributions to a section 401(k) cash or
deferred arrangement, or amounts contributed under a salary reduction SEP agree-
ment. (Drake Tax automatically adjusts salary and wages for employment credits.)

Guaranteed Payments and Partner Health Insurance

Use the DED and K screens to report guaranteed payments and partner health insur-
ance. Note that guaranteed payments and health insurance are entered as separate
amounts.

Guaranteed Payments

To report guaranteed payments to partners:

- Enter total guaranteed payments on the DED screen, line 10.
- An entry on line 4a and 4b of screen K (Income/Loss tab) adjusts the amounts
  (adds to or subtracts from) an amount entered on the DED screen.
- To allocate the total guaranteed payments among the partners, click the SA link to
  the right of the amount field on lines 4a and 4b of screen K (Income/Loss) tab.
  (For details on using the SA screen, see “Special Allocations” on page 30.)

Guaranteed payments should include any payments (or credits) to a partner for ser-
vices rendered. Include the use of any capital the partner provided if the payments (or
credits) for that capital are not determined by the partnership’s income and can be
allocated to a trade or business activity. These entries should not include any payments
and credits that should be capitalized or any distributive shares of partnership profits.

Guaranteed payment amounts are carried to the partner’s Schedule
K-1, based on percentages entered on screen K1. Amounts allocated
to the partners can be overridden on screen SA.

NOTES

Access screen K from the General tab of the Data Entry Menu, enter
K in the selector field and press ENTER, or click the Sch K Income
link at the bottom of any partner’s K1 screen. Click SA on line 4a of
the K screen to open the Special Allocations screen.

Partner Health Insurance

To report partner health insurance:

- Enter the total deductible in the Partner’s health insurance field on the DED
  screen, line 10.
- An entry on line 13d, item “M,” of screen K (Deductions tab), overrides the
  amount entered on the DED screen and the 8825 screen.
- To allocate the total amount of health insurance costs among the partners, click the
  SA link to the right of the amount field on line “M” of screen K (Deductions tab).
  (For details on using the SA screen, see “Special Allocations” on page 30.)

These amounts should include premiums for health insurance paid by a partnership on
behalf of a partner for services as a partner (including a partner’s spouse or dependents
or children under age 27 who are not dependents).

Entries flow to boxes 4 and 13 of the partners’ Schedule K-1, and to the total on line
13d of Schedule K.
For information on the partnership’s contribution to a partner’s Health Savings Account (HSA), see Notice 2005-8, 2005-4 I.R.B. 368.

**Repairs and Maintenance**

Use the **DED** screen to enter the costs of repairs and maintenance. See Form 1065 instructions for IRS requirements regarding costs that can be entered here.

**Bad Debts**

Use the **DED** screen to enter the total of all bad debts that became worthless during the 2016 tax year, but only if these debts related to a trade or business activity. Deductible non-business bad debts should be entered as short-term capital losses on screen 8949.

**NOTE**

Cash-method partnerships cannot take a bad debt as a deduction unless the amount was previously included in income.

**Rents**

Use the **DED** screen to enter rent paid on business property used for a trade or business activity. If the partnership rented or leased a vehicle, enter the total annual rent or lease expense incurred in the trade or business activity of the partnership, and then complete Part V of the 4562 (screens 8 and 9).

**Taxes and Licenses**

Use the **DED** screen to enter tax and license payment data. Amounts entered here flow to the “Taxes and licenses” line of Form 1065. Data is also generated on the ATT_PTL worksheet in View mode of the return.

**NOTE**

Credit from Form 8846, Credit for Employer Social Security and Medicare Taxes Paid on Certain Employee Tips, automatically adjusts the amount of taxes and licenses on Form 1065.

State tax amounts (income tax and franchise tax) entered on the **ES** (Estimated Taxes) screen are carried to the tax computation (ATT_TAX) worksheet. The state tax amount carried from the **ES** screen may differ depending on which method of accounting (cash or accrual) is used, and which tax type is selected.

**Interest**

The “Interest” line of Form 1065 refers only to the interest incurred by the partnership in a trade or business activity that is not claimed elsewhere in the return.

Use the **DED** screen to enter interest expense amounts. Do not include interest expense on the following:

- Debt required to be allocated to the production of qualified property
• Debt used to buy rental property or debt used in a rental activity
• Debt used to purchase property held for investment
• Debt proceeds allocated to distributions made to partners during the tax year

**Self-Charged Interest**

Self-charged interest rules (see Form 1065 instructions) do not apply if a partnership elects under Reg. section 1.469-7(g) to avoid the application of them. If the partnership is making this election, a statement must be included with the return.

To include the statement:

1. Click the **ELEC** link on screen **DED**. (The **ELEC** screen is also available from the **Miscellaneous** tab of the **Data Entry Menu**.)
2. In the **Election** drop list, select **19 - Not Apply Alternative Treatment to Self-Charged Items**.

When the return is calculated, the statement (“Statement EL19” in View mode; see Figure 6), including the required text, will be included in the return.

![Figure 6: Self-Charged Interest statement](image)

For more information on self-charged interest rules, see the “Self-Charged Interest” section of the Form 1065 instructions.

**NOTE**

Using the **ELEC** screen for this statement will not prevent the return from being e-filed.

**Depreciation**

Use screen **4562** to enter depreciable assets for Form 1065, Form 1125-A, Schedule F, Form 8825, the **RENT** screen (rental other than real estate), and Section 754. (To associate a depreciable asset with an activity, make a selection from the **For** drop list at the top of the **4562** screen.)
As explained further in the “Line 16, Depreciation” section following, the DED screen has two lines for direct entry of depreciation:

- **Line 16a** — Depreciation
- **Line 16b** — Depreciation claimed elsewhere on return

Any item entered in a depreciation field on the DED screen is added to the calculations from all 4562 screens. DED screen amounts are reflected on page 1 of Form 1065 but are not shown on any generated Form 4562.

**IMPORTANT** The depreciation fields on any screen should be used only if Form 4562 is not required.

For more information on depreciation and the 4562 screen in Drake, see the 2016 Drake Tax User’s Manual.

**Line 16, Depreciation**

Line 16c of Form 1065 is reserved for depreciation that (1) is from Form 4562 and (2) is not claimed elsewhere. While the program pulls data from the 4562 screen for this line, it also provides field 16b (Figure 7) specifically for depreciation that is claimed elsewhere.

![Figure 7: Depreciation line 16 fields from DED screen](image)

Both lines 16a and 16b on the DED screen are adjustment fields and add to or subtract from program calculations that are based on entries elsewhere in the program. Enter only the depreciation claimed on assets used in a trade or business activity:

- **Line 16a** — An entry here is added to the depreciation from the 4562 screens. The amount on line 16a is *not* reflected on Form 4562.

**NOTE** Section 179 expense does not flow to page 1, “Depreciation,” of Form 1065. It is reflected on Schedule K “Net long-term capital gain” and then distributed to each partner on Schedule K-1.

- **Line 16b** — Drake Tax recommends using screen A (rather than the DED screen) to enter depreciation claimed on Form 1125-A. An entry on screen A adjusts any entry on line 16b of the DED screen and is calculated into the total deductions on Form 1065. (The field help for the Depreciation line of screen A says it “overrides calculated amount for entries on 4563 directed to COGS.”) If there is an entry on line 16b of the DED screen but not screen A, only the line 16b amount is calculated into total deductions.

**Section 754** Use screen 4562 to enter section 754 depreciation. To associate the depreciable asset with section 754, select 754 from the For drop list at the top of the screen.
For information on allocating Section 754 depreciation to specific partners, see “Special Allocations” on page 30 and “Section 754 Allocations” on page 39.

**Section 179**

Section 179 expense is not included on Form 4562, line 22, nor is it carried to line 16a of Form 1065. It is instead reflected on line 12 of Schedule K and distributed to each partner on Schedule K-1.

**Reclassify to Amortization**

To reclassify an asset from depreciation to amortization:

1. Open screen 4562 for the asset.
2. From the Method drop list, select AMT - Amortization.
3. Complete the applicable fields in the Amortization Information section, located near the bottom-left corner of screen 4562.

**Depletion**

Enter depletion amounts on the DED screen. If the corporation claims a deduction for timber depletion, complete and attach Form T, Forest Activities Schedules. (Attach as PDF to e-filed returns. See “The PDF Attachment Process” on page 59.) Do not deduct depletion for oil and gas properties. Depletion should be figured for each partner. See “Oil and Gas Depletion Worksheet” on page 32 for more on entering oil and gas depletion in the 1065 package.

*NOTE*

The Depletion Worksheet in the partnership package is for informational purposes only. Depletion is calculated in the partner’s individual returns.

**Retirement Plans**

Use the DED screen to enter amounts for line 18, “Retirement plans, etc.” See the IRS instructions for guidance on what costs are acceptable for this line.

*NOTE*

The program reduces the expense based on the credit amount calculated from Form 8881, Credit for Small Employer Pension Plan Startup Costs.

**IRA for Employees**

If the partnership contributes to an IRA for employees, include the contributions in salaries and wages on either the DED screen (“Salaries and wages” line) or screen A (“Cost of labor” line).

**Payments to Partners**

Do not use line 18 of the DED screen to deduct payments for partners to retirement or deferred compensation plans, IRAs, qualified plans, Simplified Employee Pension (SEP), or SIMPLE IRA plans. Report these amounts, which are deducted by the partners on their own returns, on screen K (Deductions tab), item 13d, code R.

**Employee Benefit Plans**

Use the DED screen, line 19, to enter the partnership’s contributions to employee benefits programs (such as insurance, health, and welfare programs) that are not part of a pension or profit-sharing plan included in line 18, “Retirement plans, etc.”
Amounts Paid for Medical Care

The line 19 amount should not include amounts paid for insurance that constitutes medical care for a partner, a partner’s spouse, or a partner’s dependents. For information on entering amounts paid for medical care, see “Guaranteed Payments and Partner Health Insurance” on page 17.

Pub. 541

IRS Pub. 541 states that premiums for health insurance paid by a partnership on behalf of a partner for services as a partner, are treated as guaranteed payments. The partnership can deduct these payments as a business expense, and the partner must include them in gross income. The partnership cannot deduct the premiums, however, if the partnership accounts for insurance paid as a reduction in distributions for that partner. In that case, go to the K1 screen for the partner and mark the Health Insurance distribution reduction box at the bottom of the screen.

A qualifying partner can deduct 100% of the health insurance as an adjustment to income. The partner cannot deduct the premiums for any calendar month, or part of a month, in which he or she is eligible to participate in any subsidized health plan maintained by the employer of the partner or the partner’s spouse.

Other Deductions

Enter all other deductions on the DED screen. Drake calculates these amounts and incorporates the total into the “Other deductions” line of Form 1065.

The following deductions, credits, adjustments, and exclusions also flow to the “Other deductions” line:

- Amortization from Form 4562, Depreciation and Amortization
- Credit adjustment from Form 6765, Credit for Increasing Research Activities
- Credit adjustment from Form 8820, Orphan Drug Credit
- Exclusion from Form 8873, Extraterritorial Income Exclusion
- Credit from Form 8941, Credit for Small Employer Health-Insurance Premiums

Filing an Extension

Generally, a domestic partnership must file Form 1065 by the 15th day of the 3rd month following the date its tax year ended as shown at the top of Form 1065.

Calendar year returns are due on March 15, 2017. By filing Form 7004, a partnership can extend the deadline six months to September 15, 2017. Fiscal-year returns are due on the fifteenth day of the third month after the end of the fiscal year.

To file a 1065 extension, use one of the following options:

- Go to the 7004 screen in Drake Tax (Other Forms tab of the Data Entry Menu) and select Generate an extension. Complete any other applicable fields on the screen.
- Go to the PRNT screen and select Prepare a Form 7004 extension.
Signing the Return

PIN signatures are required for e-filed returns. To e-file a return, complete all fields on the PIN screen. A return cannot be e-filed if the PIN screen is not completed, including title and signature (name) of the general partner or LLC member manager. A signing date and SSN of the signing person is also required.

If the return is prepared by a paid preparer, the preparer must complete the required information and sign the return in the space provided on the PIN screen. If it is prepared by a partner or an employee of the partnership, select NONE in the Firm # and Preparer # drop lists on screen 1.

To have the preparer’s signature displayed on the printed return:

- If the return preparer and ERO (entered in Setup > ERO & Account Information) are the same:
  - Go to Setup > Preparer(s) and ensure that the Alternative Electronic Signature box is marked for the preparer.
  - Enter the preparer’s PIN on the PIN screen for the return.

- If the return preparer and ERO are not the same, go to the PRNT screen and complete the field labeled PIN for preparer’s alternative electronic signature. The PIN entered should match the one entered for the preparer in Setup > Preparer(s). (For more information, press F1 in this field.)

**Note**

Setup > ERO & Account Information must still be completed in Drake Tax for e-file. For information on how to complete this setup window, see 2016 Drake Tax User’s Manual. See the IRS instructions for further details on signature requirements.

The optional Suffix drop list and Professional text box on the PIN screen allow you to enter such designations as “Jr.”, “Sr.”, “III” to the name of the partner and such professional designations as “Dr.” or “Ret.”

**Missing PIN Information**

If you receive a state EF Message stating, “Authentication Header,” check the SSN field on the PIN screen for a missing SSN. Also make sure the Title and Signature (name) fields for the partner signing the return are completed. (SSN is not required for federal returns.)

**Form 8879-PE**

You must receive the completed and signed Form 8879-PE, IRS e-file Signature Authorization for Form 1065, before the return is e-filed. This form must be kept in the tax office for three years from the return due date or IRS received date, whichever is later.

For information on using an electronic signature pad to digitally sign Form 8879-PE, see “Electronic Signatures” in Chapter 6, “Return Results,” of the 2016 Drake Tax User’s Manual.
Amending a Return

When you amend a return in Drake, the amended information replaces the original in the data file. Before amending a return, you should archive the original to avoid losing previously submitted data. For more information on archiving returns, see “Archive Manager” in Chapter 6, “Return Results,” of the 2016 Drake Tax User’s Manual.

To file a 1065 return that has been amended:

1. Go to screen I in data entry and select Amended return in section G.
2. Make changes as applicable to forms and schedules.
3. Go to the EF screen and select Amended 1065 in the left-hand column.
4. Go to the SCH screen and complete the following fields:
   - Statement number — Select 011 - Amended Return Statement.
   - Title — Enter a statement title of 28 or fewer characters.
   - Explanation text box — Identify the amended items by line number and explain what was changed and why.

If amending just the K-1s, go to each K1 screen, select Amended K1, and make needed changes.

When amending a 1065 return, all K-1s are amended, and the “Amended K-1” box on the return is marked automatically. To override this default, go to the PRNT screen and mark Do NOT check amended box on Sch. K-1.

TEFRA and Filing Eligibility

A partnership subject to the TEFRA (Tax Equity and Fiscal Responsibility Act of 1982) audit rules cannot file an amended Form 1065 to correct a partnership item reported on a previously filed return, but according to these rules, the tax matters partner (TMP) must file a Form 8082 on the partnership’s behalf and request the IRS treat the Form 8082 as a substituted return. A partnership qualifying as a small partnership (see Section 6231(a)(1)(B)) — with 10 or fewer partners at any one time during the year — is exempt from the TEFRA audit rules and can file an amended Form 1065 and corrected K-1s to partners.

Additional Information

This section covers Schedule B (Other Information), state-specific information, and some program overrides.

Schedule B

The program has three screens for entering data for Schedule B, Other Information:

- Screen B — For all but lines 3 and 4
• Screen B1 — For lines 3a and 3b
• Screen B4 — For lines 4a and 4b

From screen B, you can access screens B1 and B4 by clicking the applicable hyperlinks (Schedule B1 and Attachment 4a and 4b) or by pressing PAGE DOWN (once for screen B1; twice for screen B4).

**NOTE** Which screens are required depends on the percentage owned. See Form 1065 instructions for calculating the maximum percentage owned.

**Ownership**
If any partner (foreign or domestic corporation, partnership, or trust) owns, directly or indirectly, an interest of 50% or more in profit, loss, or capital of the partnership, go to screen B1, the Line 3a section, and make a selection from the EIN and Name of Entity. Complete the line by selecting a type of entity, country of organization, and maximum percentage owned in profit, loss, or capital.

If a partner (individual or estate) owns, directly or indirectly, an interest of 50% or more in profit, loss, or capital of the partnership, go to screen B1 to the Line 3b section and make a selection from the ID and Name of Individual or Estate drop list. Complete the line by marking the Select if an estate check box (if appropriate), then choose a country of citizenship and enter the individual or estate’s maximum percentage owned in profit, loss, or capital.

If the partnership owned, directly, an interest of 20% or more, or owned, directly or indirectly, 50% or more of the total voting power of all classes of stock entitled to vote of any foreign or domestic corporation, use the Line 4a section of screen B4 to enter the corporation’s name, EIN, country of incorporation, and percentage owned in voting stock.

If the partnership owned, directly, an interest of 20% or more, or owned, directly or indirectly, an interest of 50% or more in profit, loss, or capital in any foreign or domestic partnership or in the beneficial interest of a trust, use the Line 4b section of screen B4 to enter the entity’s name, EIN, type, country of organization, and maximum percentage owned in profit, loss, or capital.

**Line 6 Requirements**
If question 6 on screen B is answered Yes, Schedules L, M-1, M-2, and Section L of Schedule K-1 are not required and therefore not printed. The four conditions that must be met in order to answer Yes to this question are:

1. The partnership’s total receipts for the tax year were less than $250,000.
2. The partnership’s total assets at the end of the tax year were less than $1,000,000.
3. Schedules K-1 are filed with the return and furnished to the partners on or before the due date (including extensions) for the partnership return.
4. The partnership is not filing and is not required to file Schedule M-3.

For more on line 6, see “Schedule L (Balance Sheets Per Books)” on page 41.

**Tax Matters Partner**
The designated Tax Matters Partner (TMP) is the partner who is available to discuss tax information with the IRS. TMP information is printed at the bottom of page 3 of...
Form 1065. In Drake Tax, the default Tax Matters Partner is partner #1 (the first partner entered on the K1 screen).

To designate a different partner, go to screen B and complete the Partner # field in the Tax Matters Partner section at the bottom of the screen. Note that most fields in this section are overrides; there is no need to enter additional information unless the partner’s information differs from what is provided on that partner’s K1 screen.

If you don’t know the partner number, click K1 under the General tab of the Data Entry Menu. Either an Existing Forms List or a Grid Entry list (depending on your Setup Options) displays all partners with their respective numbers (Figure 8).

**Figure 8:** Schedule K-1, Partner Numbers

### State-specific Information

#### Resident State
The program automatically generates a return for the partnership’s resident state. Use screen 2 to enter company information as it should appear on the state return. (Access screen 2 from the States tab, or enter 2 in the selector field and press ENTER.)

**NOTE**

The company information fields on screen 2 apply to the resident state only.

Company information includes the type of return that applies for state purposes (consolidated, composite, controlled group, multi-state) and state-specific dates and numbers for identification.

#### Contact Information
If certain contact information required for state purposes is different from that entered on screen 1, use screen 2 for the alternative data for registered office, principal place of business, “Books in care of,” and general contact information for the partnership’s contact person.

#### Other States
Data for other states must be entered in state data entry. To access state data entry, select the States tab from the Data Entry Menu and select the desired states for state-
Enter sales, payroll, and property factors on the **APPT Multi-State Apportionment** screen (accessible from the **States** tab or by entering **APPT** in the selector field and pressing **ENTER**). This screen (Figure 9) provides one central location for entering all state apportionment information instead of having to open each needed state’s screen.

In addition to making data input faster and easier, this feature provides two worksheets: a summary worksheet (“Wks SA-SUM”) that can be used for verifying input, and a reconciliation worksheet (“Wks SA-REC”) that ties the total of the state amounts to the federal return figures. These worksheets are available in View mode.

The individual state apportionment screens will continue to be available in Drake16 but will be used to override data entered on the **APPT** screen.

**Figure 9: APPT (Multi-State Apportionment) screen**

Mark the **Zero Apportionment** check box (Figure 9) to add a state but not include any apportionment data. This will include the state on the apportionment summary worksheet (“Wks SA-SUM”), available through View mode.

**NOTE**

The **APPT** screen is opened to the **Sales** tab. Links at the top of this screen take you to the **Payroll**, **Property**, and **Additional Property** information tabs for each state selected (Figure 9). These screens and their uses are listed in Table 1.

**Table 1: APPT Screens**

<table>
<thead>
<tr>
<th>Screen</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales</td>
<td>Select state; enter sales, returns and allowance, and other income-related information for each selected state</td>
</tr>
<tr>
<td>Payroll</td>
<td>Enter guaranteed payments to partners, salary, wage, commission, labor, and repairs amounts for each selected state</td>
</tr>
</tbody>
</table>
You may enter up to four states on one APPT screen. If you need more than four states, press PAGE DOWN for a new APPT screen. The same state can be entered more than once when additional fields are needed.

Select OT Other Reconciliation from the State Selection drop list on the Sales tab when using the reconciliation worksheet. Not every item appearing on the federal return may be subject to multi-state apportionment. When you select OT, the data entered becomes a reconciling adjustment amount to aid in tying to the federal return.

Enter as much or as little detail as the states require. If a state does not require any information to be entered, no information flows to that state’s return.

### Other Information and Overrides

Use screen 1 to enter the following additional information:

- **Resident State** — If the partnership has a mailing address in one state but does business in another, use the Resident state drop list to select the state in which the partnership does business.

- **Drake Codes and Overrides** — For information on miscellaneous codes, invoice numbers, and override fields, see the following sections of the 2016 Drake Tax User’s Manual:
  - “Listing a Different Firm, Preparer, or ERO on a Return,” in Chapter 2, “Installation & Setup.”
  - “Miscellaneous Codes,” in Chapter 5, “Return Preparation.”

- **Entity Name Control Override** — Use this field only if your client has obtained a Name Control from the IRS.
Schedule K (Partners’ Distributive Share Items)

Use the K screens to enter data for Schedule K, Partners’ Distributive Share Items.

**NOTES**

Note the screen K fields are primarily adjustment fields. Press F1 in a field to see what amounts are adjusted from elsewhere in the program. The K screens should not be confused with the K1, K1G, or other related screens.

**Screens K and KFT**

To promote greater accuracy in allocating Schedule K data to the individual partner’s Schedules K-1, and to improve the detailed statements provided to partners on their K-1s, Drake has made several enhancements to the Partnership package for 2015.

**Screen K**

Screen K is a “tabbed” screen with separate tabs for data entry of Income, Deductions, Credits, AMT and Basis, and Other Information (circled in Figure 10).

![Figure 10: Screen K is tabbed (circled at the top of the screen)](image)

Each of the tabs includes such “Other” items such as “Other” income, “Other” deductions, “Other” credits, allowing a detailed supplemental K-1 statement. (Figure 11 on page 30).
Override the calculated amounts of Schedule K items on the SA (Special Allocation) screen (Figure 12 on page 31), reached by clicking an SA link on screen K. Override the allocation of any of the items on screen K for any of the listed partners.

For example, in Figure 12 on page 31, the calculated allocation to the partners of Ordinary dividends (item #1) of $121,221, is being overridden in Dollar Amount (#2). As the allocations are entered in the Dollar Amount column, the program shows the percentage of the total that equals the dollar amount allocated (#3). The program also keeps a running total of the allocated amounts and the amounts yet to be allocated (#4). To change from allocation by dollar amount to allocation by percentages, select Percentage (#5).
**Partners’ Capital Analysis**

There are also links to the SA screen on screen M2. Use the SA screen in this instance to reconcile Schedule M-2, Analysis of Partners’ Capital, to the “Partner’s capital account analysis” in section L of Schedule K-1.

**Property Distributions**

Links to screen SA are available on screen 8825 and RENT to allow allocation of property.

**Special Partner Allocations for 3468 Amounts**

The Special Partner Allocations for 3468 Amounts link at the top-right corner of screen 3468 opens screen Schedule K Line 20C for Form 3468, allowing you to allocate investment credit amounts from Form 3468 to the partners.

**Notes**

SA screens should not be used for entering amounts on Schedule K. SA screens cannot be used for any Schedule K line with a zero balance.

**New for 2016**

When you click an SA link from screens K, M1, or M2 to make a special allocation, and enter an amount or percentage on that SA screen, the screen link on the original K, M1, or M2 screen changes color, making it easier to find those items that have been overridden.
The DEPL screen is accessible from the Other Forms tab of the Data Entry Menu. Use the For and MFC boxes to indicate which form or schedule the deduction should flow to. Create a separate depletion worksheet for each oil or gas interest. (Press PAGE DOWN to open a fresh instance of the DEPL screen.) Enter data for cost depletion, percentage depletion, or for both. If data for both cost and percentage depletion is entered, the program does both computations and sends the one that gives the taxpayer the best deduction to the proper form or schedule. (Not all taxpayers have the option of using either method. Consult Publication 535 for additional information.)

The deductions from all of the worksheets are totaled and carried to the indicated form or schedule.

NOTE

The Depletion Worksheet in the partnership package is for informational purposes only. Depletion is calculated in the partner’s individual returns.

Entries on the DEPL screen flow to the partners’ Schedule K-1, box 17, item R. Adjustments to this amount can be entered on screen K, on the Other Information cont’d tab, line 20c, item T. When you view the return, the partnership’s Oil and Gas Depletion Worksheet (“Wks DEPL”) and the partners’ K-1 DEPL worksheets will be listed in the forms tree on the left side of the View window.

Multiple Foreign Transactions

Screen Code: KFT

Information on foreign transactions are entered on a separate KFT screen, accessible from the Foreign tab of the Data Entry Menu or from a link on the Credits tab of screen K. Through the KFT screen, you can report multiple foreign transactions. (Press PAGE DOWN for a new KFT screen.)

Drake Tax generates a “Foreign Transaction Statement,” shown as “WK_FTRP” in View mode (see Figure 13), that lists all of the partnership’s foreign transactions. A separate “K-1 Foreign Transaction Statement” (K1_FTRP) is generated, reporting these foreign transactions for the individual partner.

Figure 13: New Foreign Transaction statements for 1065 and 1120S

Business Activities Statement

A Business Activities Statement (screen BAS) allow you to break down a partnership’s Schedule K items by business activity. The amounts and totals from the BAS screen do not flow anywhere in the partnership return but do provide statements you
can use as a reference when transferring these amounts into the partner’s 1040 return. A K-1 statement by business activity is also provided (Figure 14).

![Figure 14: Business Activities Statement in the 1065 package](image)

The statement is listed in View mode as “WK BAW.” The worksheets for the individual partner’s Schedules K-1 are listed as “Wks K-1 BAW.”

**Schedule K-1 for 1065 (Partner Information)**

Use the K1 screen to enter data for Schedule K-1, Partner’s Share of Income, Credits, Deductions, etc.

In the Type of Partner section, select the box on line G to describe the partner as either a General or LLC member-manager or a Limited or other LLC member (default is General). On line H, select either Domestic partner or Foreign partner (default is Domestic).

From the line I1 drop list (Figure 15), choose the type of partner (not the type of partnership). If this box is left blank, the program uses the default selection of Individual.

If the partner is a retirement plan (IRS, SEP, Keogh, etc.) mark the I2 check box.

![Figure 15: K-1 Partner Type](image)
Rounding Partner

Mark the check box on screen **K1** (Figure 16) to select which should be the “rounding” partner. That partner will be listed last on the list of partners and will be the one who receives any balancing amount on Schedule K-1 when the return is calculated.

![Figure 16: Rounding Partner check box](image)

If you do not make a selection, the software designates as the rounding partner the first partner you entered. If you select more than one rounding partner, the program generates a Return Note telling you that you’ve chosen more than one rounding partner, and also tells you which partners will be used as the rounding partner and which won’t.

Grid Data Entry

If you have your program set up to take advantage of grid data entry, you can easily enter amounts in many of the most-often used lines of a Schedule K-1. This method is particularly useful for partnerships with a lot of partners.

First, initiate grid data entry:

1. Return to the Drake **Home** window.
2. From the menu bar, select **Setup > Options** to open the **Data Entry** tab.
3. Near the bottom of the left-hand column, select **Use grid data entry format on available screens**. Click **OK**.

Now, open a return, and from the **K-1 Information** section of the **General** tab, click **K1** to open the data-entry grid. To make entries in the grid:

1. Select a partner and click one of the fields where you wish to enter data.
2. Type in information for that partner for that column.
3. Scroll across (or press the **TAB** key) to see more columns and make any entries needed.
4. Press the **DOWN ARROW** to make entries for other partners.
5. To open a partner’s **K1** screen and make any other entries, the select the line and click **Item Detail** (or press **F3**).
6. To return to the grid, close the partner’s **K1** screen (or press **F3**).
You can arrange the grid by ID number, by partner’s name, or by the amounts in the columns of the grid by clicking the column headers. Press F3 to toggle back and forth between grid data entry and a data entry screen. Right-click the grid and choose to export to an Excel or CSV file or print the grid. You can also resize the font to make the grid easier to read.

**NOTES**

**IRS K-1 Codes**

A code sheet can follow the printing of each Form 1065 K-1 to help the taxpayer interpret the various codes used on Schedule K-1. To have this sheet printed with all K-1 schedules, from the Home window of Drake, go to Setup > Options > Form & Schedule Options tab and mark the Print Page 2 of Schedule K-1... check box. The codes can also be printed on a return-by-return basis by marking the applicable box on the PRNT screen. The code sheet is also available from Tools > Blank Forms.

**NOTES**

Code sheets are not displayed in View mode. If the 1065 K-1 is selected for printing, it is printed first, followed by the statements pertaining to that 1065 K-1. These are followed by the code sheets.

The Schedule K-1 may include asterisks with letter codes.

- An asterisk with a letter code indicates that multiple items have that code, or that a statement is required for the code.
- An asterisk at the bottom of a group indicates that there are more items than can fit in the space provided for that group and a statement is attached, or that the statement is required (as in the case of “other” amounts).

**Returns with Numerous Partners**

For returns with a large number of partners, you have the option of deactivating calculation and printing of the K-1s while working on Form 1065. This option, which eases the process of reconciling the 1065, is available by going to the PRNT screen and marking the applicable box under K-1 Items to Suppress.

**NOTES**

After completing the K-1 entries for all partners, be sure to reactivate the calculation and printing of the K-1 from the PRNT screen.

**Partner Overrides**

To override calculated amounts for the partners, you can either make changes on each K1 screen or go to on of the SA screens for partner special allocations and make all changes there. For more information, see “Special Allocations” on page 30.
Foreign Addresses

If the partner has a foreign address, enter the **Province/ State, Country, and Postal Code** information in the **Foreign ONLY** address line of the **Partner Name and Address Information** section (along with the street address and city in the **Address** and **City** fields in section **F**.) Do not enter anything in the **State** or **ZIP** fields. Conversely, for a U.S. address, do not enter anything into the foreign address fields.

**NOTE**

The **Foreign ONLY** fields are locked when a return is opened. Click one of the fields to unlock them throughout the return. To relock the unused **Foreign ONLY** fields, close and then reopen the return.

Ownership Changes

All ownership change information is entered on the **OWN** screen, which is available from the **General** tab of the **Data Entry Menu**. To use the **OWN** screen:

- At the top of the screen, enter the date the profit, loss, or capital interest in the partnership was exchanged by two or more partners. If profit, loss, and capital are all involved in a transaction, put the date in the **Profit/Loss/Capital** field only. The **Loss** and **Capital** date fields are override fields, provided in case the loss or capital dates are different.
- In the **Change in Percentages** section, select the applicable partner from the drop list. (The drop list contains the names and ID numbers entered on each **K1** screen).
- Enter the percentage changes in profit, loss, or capital as positive amounts for increases and negative amounts for decreases. (See field-level help for more information.)
- To enter additional ownership changes, press **PAGE DOWN**.

**NOTE**

See FAQ item “P” in the program for more information on entering ownership-change information.

Printed Data

A Summary of Change in Ownership worksheet (“Wks POWN”) is generated when the return is viewed. The “Wks POWN” worksheet contains a list all partners and the ownership percentages and changes.

K-1 Export

Take the following steps to export a Schedule K-1 to another return.

1. Ensure that K-1 data is entered in the **exporting** 1065 return and that the **recipient** return has been created in Drake Tax. (The **K1P** screen in the other return does not have to be created beforehand.)
2. In the **exporting** 1065 return, go to View mode.
3. Click **K1 Export** in the View mode toolbar. A list of SSNs that **cannot** be exported appears, if applicable. (The reason a K-1 is ineligible for export appears in the **Reason** column.) Click **Next**.
4. The **Export K1s** dialog box (Figure 17 on page 37) lists all client SSNs that can be exported. (To prevent an item in this list from being exported, remove the check mark to the left of it.)

![Figure 17: SSNs ready to be exported](image)

5. Click **Export**. The K-1 data now appears on the partner’s 1040 tax return.

**NOTE**

Basis information for individual partners should be entered in the 1040 package in Drake Tax; this information cannot be exported from the 1065 package to a 1040 return. Such an import would override limitations and carryovers calculated in the 1040 program.

**Greater Export Flexibility**

*New for 2016:* The K-1 Export feature can now export K-1 data from partnership or fiduciary returns into the K1 “source” screens (K1P and K1F) of the 1065 package.

An **Additional Entries** tab (Figure 18) has been added to the K-1 source screens. This new tab offers 40 more fields for entering additional K-1 item.

![Figure 18: Additional Entries tab of K1P screen featuring 40 additional drop lists and amount fields](image)
Supplemental Information

Two types of supplemental information can be added to Schedules K-1:

- Supplemental data for all K-1s in a return
- Supplemental data for a single K-1 in a return

To add supplemental information “globally” (to all K-1s) enter the information in the Supplemental Information block of screen K1G. Select Global Supplemental Statement Information from the Select Type drop list, then type in the information in the large text box below. The information appears in all partners’ Schedule K-1 Supplemental Information statements.

To add supplemental information to an individual K-1 statement, open a partner’s K1 screen and click the Supplemental Info link at the top of the screen. In the Supplemental Information pane (Figure 19), enter information pertinent to the partner. The information appears in only that partner’s Schedule K-1 Supplemental Information statement.

Figure 19: In this example, the information entered on the K1S screen appears on only partner 400006666’s Schedule K-1 Supplemental Information statement.

Item M Question

If the answer to Schedule K-1, item M (“Did the partner contribute property with a built-in gain or loss?”), is “Yes” for all partners:

1. On the PRNT screen, select Yes in the Item M on Schedule K-1 section.
2. On screen K1G, select K1M - Built in Gain Loss Statement from the drop list, and type any supplemental information needed in the text box below.

If the answer is “Yes” for some partners but not others, use the individual partners’ Item M screens to report the supplemental information. The Item M screen is accessed by clicking the 8805/Item M tab at the top of any partner’s K1 screen. The supplemental information should list each property the partner contributed, the date the property was contributed, and the amount of the property’s built-in gain or loss.
Partner’s Adjusted Basis Worksheet

**NOTE** Basis information for individual partners should be entered in the 1040 package in Drake Tax; this information cannot be exported from the 1065 package to a 1040 return. Such an import would override limitations and carryovers calculated in the 1040 program.

Use the Partner’s Adjusted Basis Worksheet (Basis Wks screen) to calculate a partner’s new basis after increases or decreases are made to basis during the current year. A partner’s adjusted (outside) basis refers to the partner’s investment in a partnership. The basis is determined without considering any amount shown in the partnership books as capital, equity, or similar account. When a partner disposes of an interest in a partnership, the difference between the sale price and the adjusted basis is the taxable gain or loss.

The Basis Wks screen is accessible by clicking the Basis Wks tab at the top of the K1 screen for a partner. (Access the K1 screen from the Data Entry Menu.)

**NOTE** The Basis Worksheet (”Wks Adj Basis”) is printed only when the option is selected on the PRNT screen.

**Annual Update of Partner Information**

When the program is updated to the next tax year, the end-of-year basis and liability amounts are automatically updated to the beginning of the year. Any loss or deduction carryover is updated to the beginning of the year and its character (ordinary loss, section 179 expense, charitable contributions, etc.) maintained.

**NOTE** If a K1 screen is marked as final, none of the related screens for that partner is updated for the next year.

**Special Allocations**

Use the SA screens to allocate liability, capital, and K-1 Part III (Income, Deductions, Credits, and Other Items) amounts to individual partners without having to enter the information into each K-1 separately. Amounts can be entered as dollar amounts or percentages. Calculations from the SA screens flow to the appropriate fields of each individual K-1.

For information on the SA screens, see “Special Allocations” on page 30.

**Section 754 Allocations**

To allocate section 754 depreciation among specific partners:

1. Indicate an amount of section 754 depreciation using either (but not both) of the following methods:
   - On screen 4562, select 754 from the For drop list.
   - On screen K (Deductions tab), line 13d, item W, “Section 754 depreciation” field, enter the amount of section 754 depreciation or amortization to be reported to the partners.

2. Allocate the amounts using the SA screen. (See “Special Allocations” on page 30 for details on using the SA screen.)
Domestic Production Activities Deduction

A partnership does not take the deduction for Form 8903, Domestic Production Activities Deduction. Instead, the amounts pass through to the partners to report on their individual returns. The partners use the information to calculate their eligibility for the deduction. (For more information, see the IRS Form 8903 instructions.)

If Print K1_8903 worksheet for each partner is not selected on screen 8903, the amounts flow to line 12 of Schedule K-1 (codes U and V). If this box is selected, the information flows to the K-1 Form 8903, which is referenced on a statement. Code T is printed on line 12 of Schedule K-1 to indicate domestic production activities information.

Line 11 ("Income limitation") of the Form 8903 is not applicable for the partnership because the income limitation is calculated at the partner level.

“Form W-2 wages” (on the 8903 screen) refers to the partnership’s W-2 wages paid that are applicable to the Domestic Production Activities Deduction. Note that this is an adjustment field; an entry here adjusts amounts flowing from screens K1P or K1F.

K-1 Cover Letters

K-1 cover letters can be produced to accompany each Schedule K-1 in a return. You can set up the global option to produce K-1 cover letters for all returns containing K-1 schedules, or you can choose the option on a per-return basis.

Producing Letters for All Returns

To have the K-1 cover letters produced automatically with all applicable returns, from the Home window of Drake, go to Setup > Options > Optional Documents tab and mark the box labeled Include K-1 letter with returns. Click OK, then open a return.

The signature used on the letter flows from the PIN screen. You can override this name on the K-1 letters by going to the K1I screen and, in the K1L - Schedule K-1 Cover Letter section at the bottom of the screen, entering a name and title of the person’s signature you wish to use.

Note

If no name is entered on the PIN screen or K1L screen, the program uses the name of the partner on the first K-1 for the signature.

Editing the K-1 Letter

As with other letters provided by the program, you can edit the text to suit your office needs and style.

Tip

Review the following sections of the 2016 Drake Tax User’s Manual before making changes to letter templates:
- “Introduction to Letters in Drake” in Chapter 2, Installation & Setup
- The “Letter Keywords” section of Appendix B, Keywords

To edit the text of the K-1 letter:
1. From the Home window, select Setup > Communications Editor. The Client Communications Editor is displayed.

2. Select Open > Partnership > Partnership K-1 Cover Letter to view the template of the partnership K-1 letter.

3. Make any desired changes to the template.

4. Click Save.

For an amended return, the K-1 letter automatically refers to the amended K-1. To edit the letter for an amended K-1, from the Client Communications Editor toolbar, select Open > Partnership > Partnership K1 Amended Letter and follow steps 3 and 4 of the previous procedure.

**NOTE**

By default, the partnership’s name and address appear in the letterhead of the K-1 cover letters, the information flowing from screen 1. (This assumes you first went to Setup > Communications Editor > Setup > Page Layout and selected the Use letterhead on letters box; otherwise, no header would be printed.)

(optional) To have your firm’s contact information and logo printed in the letterhead of the K-1 cover letters, go the K1L screen, and from the Information on the K-1 coversheet... drop list at the bottom of the screen, select F - Print firm info/logo.

( optional) To prevent the partnership’s or firm’s name and address from appearing in the header of the K-1 letter, select X - Don’t print entity info from the Information on the K-1 coversheet... drop list at the bottom of the K1L screen.

Once the required signing information has been selected, a K-1 cover letter will be generated for each partner receiving a Schedule K-1.

To change the firm’s letterhead information, from the Home window, select Setup > Communications Editor. Select Open > Partnership > Letterhead (all packages) and make whatever changes you wish. Click Save.

**NOTE**

Changes made to the letterhead affects the letterhead for letters in all packages.

**TIP**

For more on working with letterheads, see “Setting Up Letterheads, Logos, Footers, Margins, and Borders” in Chapter 2 of 2016 Drake Tax User’s Manual.

**Schedule L (Balance Sheets Per Books)**

Schedule L and Schedule M-2 reconciliation totals are displayed on screens L and M2 to facilitate reconciliation of the balance sheet (item #1 in Figure 20).
Schedule L (Balance Sheets Per Books) Drake Tax Manual Supplement: Partnerships

Figure 20: Beginning- and End-of-Year totals displayed on L screen (#1); force printing end-of-year totals (#2); link to SCH2 screen (#3)

Note that the totals from the balance sheet’s subsidiary schedule (SCH2 screen link, item #3 in Figure 20) also appear in the BOY Totals and EOY Totals columns of the L screen.

If you make any changes to the data, recalculate the return (press CTRL+C) for those changes to be displayed on the screen.

**TIP**

To speed up calculation of returns that contain multiple states, open screen 1 and select 0 from the Resident state drop list.

Schedule L is not required if:

- The partnership’s total receipts for the tax year were less than $250,000
- The partnership’s total assets at the end of the tax year were less than $1 million
- Schedules K-1 are filed with the return and furnished to the partners on or before the due date (including extensions) for the partnership return
- The partnership is not filing, and is not required to file, Schedule M-3

If the partnership meets all four of these conditions, go to screen B and select Yes for line 6. Because Schedules L, M-1, M-2, and section L of Schedule K-1 are not required, they will not be generated with the return. (To force these items to be printed, go to the PRNT screen and, in the Items to Print section, select Force Schedules L, M-1, M-2, & K-1 Section L.)

If any of the four conditions are not met, select No for line 6. Schedules L, M-1, M-2, and Item L of Schedule K-1 are required and will be generated with the return.
Flow of Information

Many entries made elsewhere on the return (for example, inventory information on screen A) flow to the generated Schedule L. Depreciable asset information, intangible assets, and amortization from the 4562 screen also flow to Schedule L.

Direct entries on screen L include beginning- and end-of-year Cash, Trade notes and accounts received, bad debts, U.S. government securities, tax exempt securities, loans to partners, mortgage/real estate loans, depletable assets, and accumulated depletion. Other Schedule L data not entered on screen L would come from the partnerships’ income statement, balance sheet, and equity and capital accounts.

Force-Printing Final End-of-Year Totals

Normally, if you mark Final on screen 1, indicating that this as a final-year return for a partnership, Drake Tax “zeros out” the EOY Totals column of Schedule L. Mark the check box on screen L (see item #2 in Figure 20 on page 42) to display those totals in the EOY Totals column.

The SCH2 Screen

The SCH2 screen is used to provide detailed information required by the IRS for certain lines on Schedule L. This screen can be used in place of the actual L screen in Drake Tax. In other words, if you use this screen for all applicable lines on Schedule L, you do not need to make any entries on the L screen.

To create a statement for a line, select the line from the drop list (see Figure 21 on page 44) and enter descriptions and their corresponding amounts. Once the information is entered, or if additional descriptions are required for the line, press PAGE DOWN to access a new screen.

All line selections are carried to the next-year program when the returns are updated. Screen descriptions are updated, with the year-end amounts carried to the beginning-of-year column.

To access the SCH2 screen from the L screen, click the SCH2 Screen hyperlinks on lines 6, 8, 13, 17, or 20 (or click inside a field and press CTRL+2).

Notes

All line selections are carried to the next-year program when the returns are updated. Screen descriptions are updated, with the year-end amounts carried to the beginning-of-year column.

To access the SCH2 screen from the L screen, click the SCH2 Screen hyperlinks on lines 6, 8, 13, 17, or 20 (or click inside a field and press CTRL+2).

Statements

The total amounts entered on the SCH2 screen do not appear on the L screen in the program. They are, however, printed on the return where applicable, with references to the corresponding statements.

Note that an e-fileable “STATEMENT” is referenced in the return (Figure 21 on page 44).
SCH2 and Trial Balance

Typically, one or more SCH2 detail screens are needed for Schedule L items. If using Drake Tax’s trial balance import feature, be aware that SCH2 data cannot be entered directly into the trial balance worksheet, as they cannot be imported into the data entry. SCH2 detail screens must be created apart from the trial balance worksheet.

When the return is produced, Schedule L reflects the amounts imported from the trial balance worksheets (where direct entry was allowed). For more information, see “SCH2 Detail” on page 69.

Autobalance

Autobalance forces Schedule L to balance for both the beginning- and end-of-year amounts. The program adjusts the capital account on Schedule L by the difference between the total assets and the total liabilities and capital before the adjustment.

(Example: If Assets = $1,000 and Liabilities and Capital = $900, the program increases the partners’ capital accounts by $100.)

To deactivate this feature for a specific return, go to the PRNT screen and select Turn off autobalance.

Schedule M-2 (Analysis of Partners’ Capital Accounts)

Schedule M-2 is used to show what caused changes during the year in the partners’ capital accounts. The amounts on Schedule M-2 should equal the total amounts reported in item L of all the partners’ Schedule K-1s.
Drake Tax carries amounts entered in item **L (Analysis of Capital Account)** on the partners’ **K1** screen to Form 1065, Schedule M-2, line 1, “Balance at beginning of year.”

**Schedules M-1, M-3 (Reconciliation of Income)**

Schedule M-1 is required if the balance sheet’s total assets at the end of the year are greater than $250,000. Page 1 of Schedule M-3 is required if the balance sheet’s total assets at the end of the year equal or exceed $10 million, and Schedule M-1 and pages 1-3 of Schedule M-3 are required if the total assets equal or exceed $50 million.

**Schedule M-1**

Schedule M-1 shows all items of income and expense that are not subject to tax, plus those accounting items that are not income tax items. When required, taxpayers must reconcile book income with the taxable income.

Use the **M1** screen to enter book-to-tax difference for Schedule M-1. Book-to-tax differences are classified as permanent or temporary, and as favorable or unfavorable, as described in Table 2:

**Table 2: Examples of Book-to-Tax Difference for Schedule M-1**

<table>
<thead>
<tr>
<th>Difference</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Permanent</td>
<td>Book or tax items that will never be reported for book or tax purposes</td>
<td>- Meals &amp; entertainment limitations</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Penalties</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Tax-exempt interest</td>
</tr>
<tr>
<td>Temporary</td>
<td>Items that will be reported for both tax and book purposes, but not</td>
<td>- Depreciation</td>
</tr>
<tr>
<td></td>
<td>during the same tax year</td>
<td>- Gains or losses on the sale of depreciated assets</td>
</tr>
<tr>
<td>Favorable</td>
<td>Items that reduce taxable income</td>
<td>- Instances in which tax depreciation amount is greater than</td>
</tr>
<tr>
<td></td>
<td></td>
<td>book depreciation amount</td>
</tr>
<tr>
<td>Unfavorable</td>
<td>Items that increase taxable income</td>
<td>- Disallowed meals &amp; entertainment</td>
</tr>
</tbody>
</table>

**“Other” Adjustments**

Use the M1 **Other** adjustments screens to make adjustments to Section L, “Partner's capital account analysis,” of the partners’ Schedule K-1. To open the **Other** screen, from screen **M1**, click a blue **Other** hyperlink on lines 2, 4, 6 or 7 (circled in Figure 22 on page 46).
On the **Other Adjustments** screen, enter a **Description** and an **Amount** and close the screen. When you calculate the return, the amounts entered on the **Other Adjustments** screens have adjusted Section L of the Schedules K-1.

If you enter an amount in the line 2, 4, 6, or 7, override fields on screen **M1**, and enter that amount again on the “**Other**” **M1 Adjustment** screen, the amounts will be **added** and the **total** will flow to Schedule M-1. (Only the amount entered on the “**Other**” **M1 Adjustment** screen will affect Section L of Schedule K-1, however.)

To allocate these adjusted amount to the partners, click the **SA** link on the right side of the “**Other**” **M1 Adjustment** field. For more on using the Special Allocation (SA) screens, see “Special Allocations” on page 30.

---

**Figure 22: Other screen links from screen M1**

---

**Depreciation and Amortization Adjustments**

The program may make an adjustment for book-to-tax depreciation differences. The calculation is done with the following steps. (This procedure refers to “depreciation” throughout, but it applies for either depreciation or amortization.)

1. The amount reported on the Schedule L “Beginning of Year” accumulated depreciation (line 9b, column a) (line 10b is “accumulated depletion”), is subtracted from the “End of Year” accumulated depreciation (line 9b, column c). This is the “book” depreciation amount.

2. This “book” depreciation amount is compared to the “tax” depreciation amount. (The “tax” depreciation amount is the depreciation amount reported on the return, including any section 179 amounts).

3. The differences between the “book” and “tax” depreciation amounts are carried to the appropriate form and line.
   - If the “book” depreciation amount is greater than the “tax” depreciation amount, the difference is carried to either:
     - Schedule M-1, line 4a
     - Schedule M-3, Part III, line 25, as a negative amount
     - Form 8916-A, line 2(L), as a negative amount for assets selected on the **4562** detail screen for COGS
   - If the “tax” depreciation amount is greater than the “book” depreciation amount, the difference is carried to either:
Schedule M-1, line 7a
- Schedule M-3, Part III, line 25, as a positive amount
- Form 8916-A, line 2(L), as a positive amount for assets selected on the 4562 detail screen for COGS

Schedule M-3

The Schedule M-3 section of the Data Entry Menu includes direct access to the various M3 screens (Figure 23).

Figure 23: Data Entry Menu for M and M-3 schedules

If a domestic partnership reports on Form 1065, Schedule L, that its total assets at the end of its tax year equal or exceed $10 million (or that its gross receipts equal or exceed $250,000), it must complete and file Schedule M-3 instead of Schedule M-1.

The program calculates total assets based on IRS requirements. For more information, see the Adjusted Total Assets Worksheet produced with the return.

Some calculated amounts flow automatically to M-3; some data must be manually entered on the M3 screen. Review all amounts on the M-3.

Parts II and III of Schedule M-3 reconcile financial statement net income (loss) for the tax return (per Schedule M-3, Part I, line 11) to net income (loss) on Form 1065, page 5, “Analysis of Net Income (Loss),” line 1.

The program does not autobalance Schedule M-3. Additional data entry is required on screen M32, line 25 to reconcile with the analysis of net income.

If the partnership is required to file (or voluntarily files) Schedule M-3, the partnership must file Form 1065 and all attachments and schedules, including Schedule M-3. Additional information could be required on the 8916 and SCH3 screens.

Force-Printing Schedule M-3

Page 1 of Schedule M-3 is required if the balance sheet’s total assets at the end of the year equal or exceed $10 million, and pages 1-3 of Schedule M-3 are required if the total assets equal or exceed $50 million. If the corporation’s assets do not equal or
exceed $10 million but you want to voluntarily file Schedule M-3, or if the corporation’s assets do not equal or exceed $50 million and you wish to file the complete M-3, go to screen M3 and make a selection from the **Force print schedule M-3** drop list. Choose to print just page 1 of Schedule M-3 or the complete M-3.

See “Schedules M-1, M-3 (Reconciliation of Income)” on page 45 for more details on these schedules.

### The SCH3 Screen

The SCH3 screen is used to provide detailed information required by the IRS for certain lines on Schedule M-3 (or Form 8916-A). This screen can be used in place of the actual M3 screen in Drake. In other words, if you use this screen for all applicable lines on Schedule M-3 or Form 8916-A, you do not need to make any entries on the M3 and 8916 screens. The total amounts entered on the SCH3 screen do not show up on the actual M3 and 8916 screens in the program. They are, however, printed on the return as applicable, with references to the corresponding statements.

To create a statement for a line, select the desired line from the **Select line number from drop list** on screen SCH3, then enter descriptions and their corresponding amounts. Once the information is entered, or if additional descriptions are required for the line, press PAGE DOWN to access a new screen (make the same selection from the **Select line number...** drop list.)

**NOTE** All line selections are carried to the next-year program when the returns are updated.

As with the SCH2 screen, the type of statement produced by the program depends on the line selected on the SCH3 screen and the IRS requirements. See “The SCH2 Screen” on page 43 for more information on how to use the SCH3 screen.

### Rental Activities

**Screen code: 8825**

Income and expenses for rental real estate properties appear on Form 8825, Rental Real Estate Income and Expenses of a Partnership or an S Corporation. To make entries in Drake Tax, use the 8825 screen, available from the **Other Forms** tab of the **Data Entry Menu**.

If there are multiple 8825 properties, press PAGE DOWN for a new 8825 screen. Use one screen per rental property. If a return has more than one 8825 screen, the program reports each property’s information on a separate column of Form 8825. Data from all 8825 screens are transmitted to the IRS when the return is e-filed.

**NOTE** Special steps are required if using the trial balance worksheet for multiple rentals. See “Rental Expenses” on page 70 for more information.

### Line 14, Depreciation

If the program is calculating depreciation (entered on the 4562 screen) for the property listed on the 8825, do not enter the depreciation on the 8825 screen. Depreciation should be entered only if it is figured outside of the Drake Tax program, and then the
net results should be entered on screen 8825. The amount entered on line 14 is added to the depreciation calculated from the 4562 screens.

**NOTE**
For assets placed in service during the year, Form 4562 is required. Drake Tax produces one Form 4562 for each property on Schedule E and Form 8825 instead of one 4562 per Schedule E or 8825.

To indicate that the information should be carried to Form 8825, select 8825 from the For drop list on screen 4562 (Figure 24). If there are multiple 8825 screens, use the Multi-form code box. For information on using the Multi-form code box, see the 2016 Drake Tax User’s Manual.

![Figure 24: In this example, the program carries the 4562 information to the third 8825 screen created.](image)

Any depreciation information entered on the 4562 screen is carried to the correct Form 8825, based on the form and multi-form code selections at the top of the 4562 detail screens.

When selecting a multi-form code, note that the code should refer to an 8825 screen—not the 8825 form. For example, data from the third 8825 screen will be generated on the first Form 8825. To associate an asset with that information, you would enter a “3” for the screen (not a “1” for the form) in the Multi-form code box. For more information on Form 8825, see “Viewing Rental Activity Information” on page 50.

**IMPORTANT**

For rental properties with an “other” expense (line 15 of Form 8825), enter the amount of guaranteed payments, health insurance payments, and meals and entertainment in the appropriate fields of the 8825 screen (see Figure 25 on page 50). For rental properties with expenses not listed, enter those amounts in the Additional other expenses field. (An entry in this field opens a Detail Worksheet. Enter a description in the Description field and an amount in the Amount field.) The shaded field indicates a worksheet was entered.
Totals from the worksheet flow to Form 8825, and a statement from each property is printed with the return and is transmitted to the IRS when the return is transmitted.

Enter rental income the partnership receives on a Schedule K-1 on the K1P screen. This amount flows to Form 8825, lines 20a and 20b. No entry is required on the 8825 screen.

Viewing Rental Activity Information

Rental activity data is viewed on the 8825 forms and accompanying statements.

- **8825 Forms** — Form 8825 can contain information for up to eight rental activities. If more than four rental activities are entered, a second page of Form 8825 is generated. If more than eight rental activities are entered, a second Form 8825 is created (Figure 26).

- **8825 Statements** — Statements are titled STM 8X, where “X” equals “A” to “H” for the first Form 8825. (For example, the statements for the first and second 8825 screens would be labeled STM 8A and STM 8B, respectively.) (See Figure 27.)
Self-Employment Income

If **Mark this box to include in self-employment income** is selected at the top of the **8825** screen, the amounts from the **8825** screen are included in the calculation for line 14a of Schedule K and flow to each K-1. Self-employment calculations are shown on the “Wks Sch K” worksheet generated with the return.

Royalties Worksheet

When royalty income and expenses are listed on screen **8825** (and **Royalties** is selected from the **Type of property** drop list), Drake Tax generates the Royalty Worksheet (“Wks PROY” in View mode), along with a K-1 Royalty Worksheet (“Wks K-1 PROY”) for each partner.

When a 1065 return is viewed, instead of the royalties income and expenses flowing to box 2, “Net rental real estate income,” of Schedule K-1, gross royalties flow to Schedule K, line 7, “Royalties,” and expenses to Schedule K, line 13d, “Other deductions.” These amounts are also on the Royalty Worksheet.

Form **8825** isn’t generated unless it is otherwise needed.

Credits and Adjustments

Certain credits require an adjustment to either income or expenses. Drake Tax carries the required adjustments to the appropriate line of the return and to the M-1.

**NOTE**

No adjustment is carried to the M-3 automatically for 2016.

Manually reducing the expenses/deductions or increasing the income for these credits causes the return to be out of balance.
Adjustments are made to other income for the credit amounts for the following credits:

- Form 6478, Biofuel Producer Credit
- Form 8864, Biodiesel Fuels Credit
- Form 8912, Credit to Holders of Tax Credit Bonds (interest income)

Adjustments are made to the appropriate deduction/expenses for the credit amounts for the following credits:

- Form 5884, Work Opportunity Credit
- Form 6765, Credit for Increasing Research Activities
- Form 8820, Orphan Drug Credit
- Form 8845, Indian Employment Credit
- Form 8846, Credit for Employer Social Security and Medicare Taxes Paid on Certain Employee Tips
- Form 8881, Credit for Small Employer Pension Plan Startup Costs
- Form 8844, Empowerment Zone Employment Credit
- Form 8912, Credit to Holders of Tax Credit Bonds
- Form 8941, Credit for Small Employer Health Insurance Premiums

**Elections**

The ability to make certain tax elections is included in the Partnership package. Elections are made and described on the ELEC screen (Figure 28).

![ELEC Screen with Election Fields](image)

*Figure 28: Election fields of ELEC screen*
Making an Election in Drake

To indicate that the partnership is making an election:

1. Open the ELEC screen (accessible from the Miscellaneous tab of the Data Entry Menu).
2. Make a selection from the Election drop list.
3. Complete all other fields as applicable. Press F1 in any field to learn if that field is required for your selection and the type of information that may be needed. For example, the help text for the Date or year-ending field (Figure 29) shows that the field is required only for election options 08, 11, 13, 15, and 21, and it explains what, specifically, should be entered for each of these elections.

![Figure 29: Help text for Date or year-ending field on ELEC screen](image)

NOTE

If the election option you selected is not listed in the help text for a field, then that field should be left blank. For example, if you chose election 01 (General Election Statement), you would not need to enter anything into the Date or year-ending field (help text in Figure 29).

To open a new ELEC screen for an additional election, press PAGE DOWN.

Election Statements

Once an election is made and the return is calculated, the election information is produced on a statement referenced “Statement EL XX,” where “XX” is the number of the election. For example, election 01 (General Election Statement) is generated as “Statement EL 01.”

The election statement includes the election title, election wording, and any additional information required for the election, such a date, amount, or location.

Entries for certain fields are sometimes included in the actual election statement; other times, they are included as separate lines. Signature lines are printed as needed on some statements.
Safe Harbor Elections

A **Building qualifies as Section 1.263...** check box on screen 4562 applies a small taxpayer Safe Harbor election to a building listed in the **Description** field. An election statement will be produced and the building description as entered in the **Description** field will be included in the election statement (see Figure 30).

**NOTE**

This Safe Harbor election covers buildings only.

This Sec. 1.263(a) - 3(n) Election can also be made from the **ELEC** screen, as can a Sec. 1.263(a) - 1(f) de minimis safe harbor election.


Election statements are generated with the return (Figure 30).

![Figure 30: Election statements, including Safe Harbor election](image)


Making Changes on the Fly

Use the **PRNT** screen to override program defaults.

Suppressing/Forcing Documents

To suppress or force the printing of certain documents, go to the **PRNT** screen and select the desired options. Many “on the fly” changes override global setting from Setup Options.

**1065 Items** The following Form 1065 items can be “forced” (forced to be generated or printed) or suppressed from the **PRNT** screen.
• Force Schedules L, M-1, M-2 & K-1 Section L — Schedules L, M-1, M-2, and K-1 Section L are not printed unless required. To have these schedules printed with the return, select this box.

• Print Form 8893, Election of Partnership Level Tax Treatment — Select this box to generate Form 8893 with the return. (There is no equivalent 8893 screen, but the form is produced. All information for the form is available from other data entry screens.)

• Print Form 4562 — Form 4562, Depreciation and Amortization, is not generated unless applicable. Select this box to force the Form 4562 to be printed. (To force Form 4562 for all returns, go to Setup > Options > Form & Schedule Options, and clear the check box labeled Print Form 4562 only when required.)

• Print next-year depreciation listing — Select this box to print the next year’s depreciation schedule if the option is not already selected in Setup > Options > Form & Schedule Options.

• Print inactive return — By default, the program does not generate a return for a partnership that is inactive. Select this option to override the default for an inactive return.

• PIN — To have the preparer’s signature appear on the printed copy of return, enter the preparer’s PIN here.

• Items to Suppress — Select the boxes corresponding to any worksheets, forms, or functions you do not want printed with the return:
  – ATT_PTL (Taxes and Licenses Attachment) or the ATT_PSW reference on page 1
  – Estimated Tax Payment Summary
  – Printing of WK_M2, Partners’ Capital Reconciliation Worksheet

**K-1 Items** Described below are Schedule K-1 items that can be forced or suppressed from the PRNT screen:

• Select to print:
  – The partner’s adjusted basis worksheet
  – Page 2 of Schedule K-1 (codes)

• Select to Suppress:
  – Schedule K-1, K-1 letter, K-1_ATT, or WK_PBAS
  – Schedule K/K-1 Comparison Worksheet or the Capital Account Reconciliation
  – K1_179 for each partner
  – Marking of “Amended K-1” box on printed Schedule K-1

• Item L on Schedule K-1 (Partner’s capital account analysis) — Select the box (item #1 in Figure 31 on page 56) to indicate the calculation method used for the partners’ capital account. (If **Other**, indicate the method in the text box; this item is required.)
Figure 31: Items L and M of PRNT screen

- **Item M on Schedule K-1** — Select a box (item #2 in Figure 31) to answer item M of Schedule K-1 for all partners. To answer it for each individual partner, go to the partners’ K1 screens. See “Item M Question” on page 38 for more information.

See field helps (F1) for more information on the options available.

**Overriding Other Setup Options**

Filing instructions (federal and state) and envelope coversheets (partnership, IRS, state, city, and K-1s to partners) can be either forced or suppressed from the PRNT screen to override the global selections in Setup Options.

In addition, you can select **Turn off autobalance** to disable the autobalance feature (see “Autobalance” on page 44) and select **Prepare a Form 7004 extension** if sending an extension application. (See “Filing an Extension” on page 22.)

The following program default settings can also be overridden from the PRNT screen:

- Date to print on return
- Due date to print on letter and filing instructions (see note below)
- Amount on Form 1065, page 1, item F (“Total assets”)
- IRS Service Center

**NOTE**

A default due date for filing is printed on all letters and filing instructions generated with a return. You can override the default by entering an alternate due date in the **Due date to print on letter and filing inst** field.

Much of the information contained in the worksheets is also available from the field-level helps within the program. To access a field-level help, click inside a field and press F1, or right-click in a field and select **Help > Help for this Field**.

**Electronic Filing**

Some partnerships with more than 100 partners are required to e-file Form 1065, Schedules K-1, and other related forms and schedules. For other partnerships, e-file is optional.
Steps for e-filing Form 1065 are the same as for e-filing Form 1040, with the exception of a bankruptcy return, which must be paper-filed. For detailed instructions on e-filing returns in Drake Tax, see 2016 Drake Tax User’s Manual.

Additional Return Types

The following special types of business returns can be e-filed using Drake Tax:

- Returns for entities using a 52-53–week year
- Short-year returns
- Inactive returns

For information on how to indicate a short-year return in Drake Tax, see “Short-Year Returns” on page 13.

To elect a 52-53–week year, a new entity (one that has never filed a return) must enter data on both screen 1 and the Year screen.

To elect a 52-53–week year for any entity:

1. In the If not calendar year section of screen 1, enter the Fiscal year beginning and Fiscal year ending dates. Use MMDDYYYY format, as shown in the example in Figure 32.
2. Mark the 52-53-week tax year box.

![Figure 32](image)

In this example, the fiscal year begins 12/26/16 and ends 12/25/17 (the Monday closest to the end of December), giving the entity a 53-week year for 2017.

**Note** An entity that has filed returns in the past must complete only steps 1 and 2 of this process. An entity that has never filed a return before must continue with steps 3 through 6.

3. Click the Year link to open the Election Options screen (Figure 33).

![Figure 33](image)

Elections for 52-53–week tax years
4. For line 1, select the month in which the 52-53–week year ends for the current fiscal year. (01 = January, 02 = February, etc.)

5. For line 2, select the day of the week the tax year always ends.

6. For line 3, enter the actual date that the tax year ends (the same date entered in the Fiscal year ending field on screen 1).

Once a 52-53–week year is selected, the entity must use that accounting period every year. To change accounting periods, the entity must submit to the IRS Form 3115, Application for Change in Accounting Method. Screens for completing Form 3115 are available from the Other Forms tab of the Data Entry Menu.

In subsequent years, only the 52-53–week tax year check box on screen 1 must be marked; the program automatically updates the dates.

NOTE

Inactive Returns

Entities that are inactive but are still required to file returns may e-file inactive returns in Drake Tax. To indicate that a return is inactive:

1. Go to the PRNT screen, accessible from the General tab or the Miscellaneous tab of the Data Entry Menu.

2. Under Items to Print, mark the Print inactive return box.

When the return is calculated, the program displays the words “Inactive Return” on the main form of the return (specifically, to the right of lines 1a and 1b). Zeros (“0”) are displayed where required by the IRS in order for amounts to be properly included in the e-file data.

NOTE

All EF Messages must be cleared in order to e-file an inactive return.

Common Reject Codes

If one or more of the following IRS reject codes are generated when you e-file a 1065 return, you must contact the IRS for further information. The e-file help desk number is (866) 255-0654.

• Reject Code R0000-922-01 — Filer’s EIN and name control in the return header must match data in the E-File Database, unless “Name Control” or “Name of address change” check box is checked, if applicable.

• Reject Code R0000-900-01 — The return type indicated in the return header must match the return type established with the IRS for the EIN.

NOTE

If a reject associated with the return’s “Name Control” occurs, some of your questions can be answered on the IRS’s website. For details, go to www.irs.gov/Tax-Professionals/e-File-Providers-&-Partners/Using-the-Correct-Name-Control-in-e-filing-Partnership-Tax-Returns
Binary Attachments

Binary, or PDF, files can be attached to certain tax forms. These attachments are generally signature or third-party documents such as a copy of a signed lease or a signed appraisal statement. In some instances, the IRS requires that a document be attached to an e-filed return; in other instances, a document can be attached voluntarily to support or explain an entry in the return. In either case, a document must be printed, scanned into the computer, and attached to the return in order to be e-filed with the return.

The PDF Attachment Process

Three main steps are involved in the PDF attachment process in Drake Tax:

1. Creating a PDF document to be attached
2. Informing the program that a PDF document will be sent with the return
3. Attaching the PDF document for e-file

These steps are described in the following sections.

Creating a PDF File

To create a PDF file:

1. Scan the document to be attached to the return.

**TIP**
It's a good idea to use the Drake Document (formerly DDM) scanning feature for this step.

2. Save the document to your client’s Drake Documents file, your computer’s desktop, or anywhere you can readily find it.

**NOTE**
Many types of documents (for instance, documents created in Microsoft Word) can be printed or "saved" as PDF documents if you have a PDF printer (such as Adobe Reader) installed.

Adding PDF Documents in Drake

To indicate in the software that a PDF document will be sent with the return:

1. Open the return in Drake Tax.
2. From the Data Entry Menu, click PDF Attachments, accessible from the Electronic Filing section of the General tab (or type PDF in the selector field and press ENTER). (Figure 34)
3. Fill out the columns on the PDF Attachments screen. See Table 3 for examples.

Table 3: PDF Attachment Window Columns

<table>
<thead>
<tr>
<th>Name of Column</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference Source</td>
<td>Name or number of regulation, publication, or form instruction that makes attachments necessary</td>
<td>- IRS Pub xxx-1.4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Form Instructions for 1065</td>
</tr>
<tr>
<td>Description</td>
<td>Description of form or document to be attached</td>
<td>- Title of house on Oak Street</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Appraisal of Lot 1234</td>
</tr>
<tr>
<td>File name</td>
<td>Distinctive, easily recognizable file name, followed by &quot;.pdf&quot;</td>
<td>- TitleHouseOakSt.pdf</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- AppraisalLot1234.pdf</td>
</tr>
</tbody>
</table>

4. Exit the PDF Attachments window.

Because you’ve indicated that a PDF document is attached, the program generates an EF Message regarding the attachment when the return is calculated.

To attach a PDF file to a return:

1. From the return, click View. If anything was entered in the PDF Attachments window, there will be two PDF–related items in the View/Print window:
   - An “MESSAGES” alert (item #1 in Figure 35)
   - An Attach PDF button on the toolbar (item #2 in Figure 35)
Figure 35: The MESSAGES file (1) and the Attach PDF button (2)

2. Click the MESSAGES file to view EF Messages, including information on how to attach the required documents to the return.

3. Click the Attach PDF button. The EF PDF Attachments window displays the information entered on the PDF Attachments window in data entry. A red X means the document has not yet been attached; a green check mark indicates an attached document (Figure 36 on page 61).

4. Click the row of a document to attach.

5. Click Browse.

6. Find to the proper folder, select the PDF file to attach, and click Open (or double-click the file name).

Repeat for all documents with a red X. When all documents have been attached to a completed return (and show a green check mark), recalculate the return. If all EF Messages have been resolved, the return is ready to be e-filed.
Importing Trial Balance Information

Drake Tax’s trial balance import feature allows data to be imported into a 1065 return from a trial balance worksheet. The trial balance template and importing function has the following benefits:

- Eliminates the need to duplicate entries
- Reduces data entry errors by automatically importing data to the correct fields
- Allows preparers to merge basic accounting functions with tax preparation

**NOTE**

A flow chart of the trial balance importing process is available as Appendix A, Trial Balance Import (pages A-1 to A-2 of this manual).

Preparing to Use Trial Balance Import

The trial balance import function can be used only on returns that were created in Drake Tax 2008 or later. Like several other functions of the tax software, this feature requires Microsoft Excel (version 2000 or later).

First, if you haven’t already, create a client file (open a new return) in Drake Tax 2016 or update an existing client file from the prior year. Then create a trial balance worksheet. (See “Opening a Template” on page 63.)

Take the following steps to ensure the trial balance import works properly:

- **Activate Macros** — The trial balance import function uses macros in Microsoft Excel. Check your Excel settings to ensure that macros are activated and that macro settings are set to “Disable all macros with notification.” To do so, go to File > Options in Excel and select the Trust Center tab. Click Macro Settings and select Disable all macros with notification, then click OK.

**NOTES**

In Excel 2007, click the Office button in the upper left and then click the Excel Options button at the bottom of the window. (In Excel 2013, click the File tab then select Options from the menu on the left.) Next, select Trust Center from the list at left, then click the Trust Center Settings button. Select Macro Settings from the list on the left, then choose Disable all macros with notification. Click OK and then OK.

- **Disable Autobalance in Drake Tax** — (optional) When autobalance is disabled, the program is prevented from automatically adjusting the year-end retained earnings or capital amounts, thus allowing you to see any discrepancies in the balance sheet. To disable autobalance in Drake Tax, go to the PRNT screen and select Turn off autobalance (Figure 37).

![Figure 37: Disable autobalance in Other Return Options section of PRNT screen](image-url)
• **Force Schedule L** — By default, the program does not display the balance sheet amounts on the return if the partnership does not meet the filing requirement. If this is the case, you will have to override the default setting in order to have the amounts displayed on Schedule L. To force the Schedule L amounts to be printed, go to the **PRNT** screen and select the **Force Schedules L, M-1, M-2, & K-1 Section L** box (Figure 38).

![Figure 38: Force Schedule L box for 1065 package](image)

• **Check for Detail Worksheets** — The trial balance import allows only those detail worksheets required by the IRS. Check updated returns for detail worksheets (CTRL+W) that are **not** required. For example, the IRS does not require a detail worksheet for the **Gross receipts** field on the **INC** screen; if a return has a detail worksheet for that field, the trial balance will not be imported correctly into the return. Detail worksheets are indicated by red shading, as shown in Figure 39.

![Figure 39: Example of an “unnecessary” detail worksheet](image)

Remove unnecessary detail worksheets prior to import. See “Detail Worksheets” on page 65 for more information on using detail worksheets in the trial balance.

### Preparing Financial Data for Import

To prepare the financial data for importing into the return, the data must be entered into Drake Tax’s specially designed trial balance template. Once this information is entered and saved, it can be imported into the return.

**Opening a Template**

The first step in preparing financial data for importing is to open a trial balance template for the return and enter the financial data.

To open a trial balance template for a return:

1. Open the return to the **Data Entry Menu**.
2. Click **Import > Trial Balance Import** from the **Data Entry Menu** toolbar. The preliminary **Trial Balance Import** dialog box is opened.
3. Click **Create New** or **Open Existing**. If opening an existing file, click **Open** after selecting the correct file.

4. If a **Security Warning** box appears, click **Enable Macros**.

**NOTE**

In Excel 2007 and 2010, you may see a **Security Warning** message with an **Options** button. Click **Options** to open the **Security Options** dialog box, then select **Enable this content**. Click **OK**. (In Excel 2013, click **Enable Content**.)

The trial balance template is displayed in Microsoft Excel.

**File Location**

Whenever a new template is opened, the tax software assigns it a default file location and name. Trial balance templates are saved in the “TB” folder of your Drake16 program.

To change the name of a file in Excel, select **File > Save As** and assign the new name.

**NOTE**

If saving a trial balance to a different location, make a note of where you store it. The program automatically looks in the default directory.

**Template Structure**

The trial balance template consists of three title rows and six columns. The **Entity Name** and **Year End** title rows can be edited; double-click a row to change the title. Columns are described in Table 4.

**Table 4: Trial Balance Template Columns**

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Title</td>
<td>Title of account</td>
</tr>
<tr>
<td>Debit/Credit</td>
<td>Debit and credit amounts</td>
</tr>
<tr>
<td>Import to</td>
<td>Screen and line in Drake Tax to which the debit or credit amount is imported</td>
</tr>
<tr>
<td>Reported on</td>
<td>Location of the amount on the printed return</td>
</tr>
<tr>
<td>Other Information</td>
<td>Additional details for preparers; see &quot;Details for Preparers&quot; on page 68.</td>
</tr>
</tbody>
</table>

Displayed at the bottom of the trial balance worksheet are the calculated amount for Schedule M-1, line 1; the credit and debit totals; and a cell showing whether or not the balance sheet is out of balance and, if applicable, the out-of-balance amount (Figure 40 on page 65; see also Figure on page 66).
Following are instructions and guidelines for using the trial balance template to assemble financial data for importing into data entry.

**Entering Financial Data**

When a new trial balance file is opened for a return, all debit and credit amounts are zero ($0). All data must be entered manually into the template.

**NOTE**

Some data cannot be imported from the trial balance worksheet into the tax program and must be entered directly into the data entry fields within the Drake Tax program. For more on these categories of data, see “Special Conditions” on page 68.

**Direct Entry**

Most cells in the trial balance worksheet are view-only. In a new template, editable debit and credit cells are indicated by a dollar amount ($0).

**Detail Worksheets**

Some cells require more detail than can be entered on a single line. These cells are indicated by buttons (Figure 41). If these cells do not work, you may need to enable them; see the Note in “Opening a Template” on page 63.

![Figure 41: Example of cells that require worksheets](image)

Click a worksheet button to open a worksheet in a new tab. Figure 42 on page 66 shows an example of the “Other Income” worksheet.
To return to the previous worksheet, click the PTR TB tab (#1 in Figure 42) or click the Click to return to TB button above the worksheet tabs (#2 in Figure 42). Note that a detail tab (the “Other Income Detail” tab, #3 in Figure 42 on page 66) might include one or more detail worksheets.

**NOTE** Do not create detail worksheets in data entry of Drake Tax if the trial balance worksheet does not provide an equivalent detail worksheet or the trial balance will not be imported correctly.

**Totals**

Totals are displayed at the bottom of each worksheet. If credit and debit columns are out of balance, the worksheet highlights the out-of-balance amount (Figure 40 on page 65).

In addition to credit and debit totals, the main trial balance worksheet shows the net income (loss) to be calculated for line 1 of Schedule M-1 after all entries and adjustments are made in the software.

**NOTE** The data cannot be imported into Drake Tax if the worksheet is out of balance.
Saving a File

To save a file, click the Save icon or select File > Save from the menu bar. (In Excel 2007 and 2010, click the Office button in the upper-left corner and select Save. In Excel 2013, click the File tab then Save.) To re-name a file when saving, select File > Save As. Trial balance templates are saved in the “TB” folder of your Drake16 program.

Importing Data into a Return

Once a trial balance worksheet has been set up for a client in Drake Tax, the trial balance information can be imported into the program and calculated into the return.

Not all trial balance data can be imported directly into a return. For information on program limitations, see “Special Conditions” on page 68.

If you are already in the Trial Balance Import tool for the selected return, go to the Trial Balance Import window in Drake Tax and start at Step 3 of the following procedure.

To import a trial balance into a return:

1. Open the return to which you will import the trial balance information.
2. Click Import > Trial Balance Import from the menu toolbar. The preliminary Trial Balance Import dialog box is opened.
3. Click Next.
4. Enter or select the trial balance file to be imported. Use the Browse feature if necessary. By default, each trial balance file is an Excel (.xls) file displaying the client’s name and ending in “TB” for trial balance, as shown in the example in Figure 43 on page 67. (See “File Location” on page 64.)

![Figure 43: Selected file to import](image)

5. Select the Trial Balance Additional Import Options. (See “Additional Import Options” following this procedure.)
6. Click Next and wait for the import to be completed.
7. Click Finish.

The program returns to the Data Entry Menu for the open return. Note that all selected data from the trial balance worksheet has been imported into the return. This can be seen both in the data entry screens and on the generated return.
**Additional Import Options**

By default, the program imports the following additional information when importing the trial balance data. Select the items to import or click **Select All** then click **Next**:

- Buildings and other depreciable assets
- Goodwill and other intangible assets
- 8825/Rent information
- COGS depreciation
- Accumulated depreciation
- Land
- Accumulated amortization

**Special Conditions**

Some trial balance items cannot be entered into the trial balance worksheet and must be typed directly into Drake Tax data entry. Other items should be entered into the worksheet for balance purposes but are not carried to data entry; these must be entered separately and the calculated results compared to the trial balance worksheet.

**Details for Preparers**

Most trial balance items are imported directly to the location indicated in the program and on the return. For example, the amounts shown in Figure 44 go to Schedule L, line 1, column d in the program and are shown on page 5, line 1, column d of the 1065 return.

**Figure 44**: Indication of where an amount will go in Drake and on the return

The “Other Information” column in the trial balance worksheet indicates special conditions and additional information regarding certain rows. Table 5 describes the most common notes in this column.

**Table 5**: “Other Information” Column Notes

<table>
<thead>
<tr>
<th>Note</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>not included in totals</td>
<td>The amount is required for importing purposes only but is not included in the totals shown on the trial balance.</td>
</tr>
<tr>
<td>does not import</td>
<td>Information cannot be imported and must be entered on the appropriate screen in Drake Tax. Screen is specified in the “Reported on” column to the left of “Other Information.”</td>
</tr>
<tr>
<td>optional</td>
<td>Amount is optional; not required for import, but could require direct entry in the program.</td>
</tr>
<tr>
<td>enter as negative number</td>
<td>Some deficits must be entered as negative numbers.</td>
</tr>
<tr>
<td>import includes the calculated change in inventory</td>
<td>Used for “total purchases”; when calculating cost of goods sold (COGS) in the return, the program takes the change in inventory into account for the Schedule A calculation.</td>
</tr>
</tbody>
</table>
All “does not import” notes are accompanied by further instructions in the “Reported on” column to the left of the “Other Information” column, as shown in Figure 45.

**SCH2 Detail**

Typically, a balance sheet subsidiary schedule (SCH2 detail screen for Schedule L) is required for an item marked “does not import” on the trial balance. (Figure 45)

<table>
<thead>
<tr>
<th>Account Title</th>
<th>Debit</th>
<th>Credit</th>
<th>Import Exp</th>
<th>Reported on</th>
<th>Other Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash</td>
<td>$0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other current assets</td>
<td>$5,550</td>
<td></td>
<td>L. line 5a, col b</td>
<td>SCH2 detail required in Drake</td>
<td>does not import</td>
</tr>
<tr>
<td>Loans to partners</td>
<td>$3,333</td>
<td></td>
<td>L. line 7a, col d</td>
<td>1065, page 5, line 7a, col d</td>
<td>SCH2 detail required in Drake does not import</td>
</tr>
<tr>
<td>Mortgage and real estate loans</td>
<td>$1,234</td>
<td></td>
<td>L. line 7b, col d</td>
<td>1065, page 5, line 7b, col d</td>
<td>SCH2 detail required in Drake does not import</td>
</tr>
<tr>
<td>Other investments</td>
<td>$5,435</td>
<td></td>
<td>L. line 19a, col c</td>
<td>1065, page 5, line 19a, col c</td>
<td>SCH2 detail required in Drake does not import</td>
</tr>
<tr>
<td>Building and other depreciable assets</td>
<td>$3</td>
<td></td>
<td>L. line 19b, col c</td>
<td>1065, page 5, line 19b, col c</td>
<td>SCH2 detail required in Drake does not import</td>
</tr>
</tbody>
</table>

**Figure 45: SCH2 screen required for “does not import” items**

To complete an SCH2 detail screen in the tax program:

1. Open the SCH2 screen for the return.
2. Select the line number from **Select line number from drop list**.
3. Enter the applicable item descriptions and beginning- and end-of-year totals.

To enter details for additional lines of Schedule L, press **PAGE DOWN** and repeat steps 2 and 3. Data is saved automatically upon entry.

When the return is produced, Schedule L of the return reflects both the amounts imported from the trial balance worksheet and the totals of the amounts entered on the SCH2 screens.

**Depreciation**

Partnership (1065) returns can have up to four components of total depreciation:

- COGS
- Real estate rental
- Rental other than real estate
- Any remaining depreciation

For trial balance purposes, enter depreciation amounts directly into the appropriate fields on the trial balance worksheet. Note that rental expense detail worksheets are required for **8825** and **RENT** depreciation.

**Note**

Enter **8825** and **RENT** depreciation amounts in the detail worksheets for importing purposes, but be aware that the **8825** and **RENT** screens in the program will need to be edited if **4562** detail screens (see Figure 46 on page 70) are used.

When the trial balance is imported, the COGS depreciation expense amount flows directly to the appropriate line of Schedule A on the return, and the rental depreciation expense amounts flow directly to the appropriate lines of the **8825** and **RENT** screens, as applicable. Because the remaining depreciation can comprise any number of assets, the amount entered on the trial balance does not flow to the return. To ensure that each...
component of the total remaining depreciation is calculated into the return, each asset must be entered on the applicable depreciation screens in data entry (Figure 46).

![Depreciable Assets](image)

**Figure 46:** Enter depreciable asset data on a 4562 detail screen, or enter the total depreciation on the override screens

Entering the remainder of the depreciation on the trial balance worksheet helps ensure that the balance sheet balances and provides a way to check that the amount on line 1 of Schedule M-1 is correct. Compare the calculated line 1 amount at the bottom of the trial balance to the equivalent line on Schedule M-1 of the calculated return. If the depreciation amounts match but the line 1 amounts differ, an M-1 adjustment could be required.

**NOTE**

The following information applies only for partnerships with multiple rental properties.

The partnership trial balances include lines for rental income and expenses (Figure 47). Both rental expense items require a trial balance detail worksheet.

![Rental Expenses](image)

**Figure 47:** Rental expense rows on a trial balance worksheet

When imported, the rental expense data entered on the trial balance worksheet appears on either the 8825 screen (if real estate rental) or the RENT screen (if rental other than real estate).

Because the trial balance worksheet has only one detail screen per rental type, the importing function does not accommodate entities with multiple rental properties or expenses; however, the following procedure allows the trial balance to remain in balance if there are multiple rental properties or expenses.

To accommodate entities with multiple rental properties or expenses:

1. Calculate the totals for both types of rental expenses.
2. Enter the income totals on the trial balance sheet and the expense totals on the applicable detail sheets (Figure 47).
3. Ensure that the balance sheet is in balance.
Form 3115, Application for Change in Accounting Method

Form 3115, Application for Change in Accounting Method, is an application to the IRS to change either an entity’s overall accounting method or the accounting treatment of any item.

Form 3115, Application for Change in Accounting Method, is eligible for e-file.

Drake Tax customers can fill out and e-file Forms 3115 and related schedules and attachments for partnership returns.

In some cases, Form 3115 must still be paper-filed.

Applicants filing Form 3115 should refer to Rev Proc. 2015-13 for general automatic change procedures, and to Rev Proc. 2015-14 for a list of automatic changes to which the automatic change procedures in Rev. Proc. 2015-13 apply.

Accessing Screens for Changing Accounting Method

Several screens may be required to complete Form 3115. These screens are accessible from the Change in Accounting Method box, located under the first Other Forms tab of the Data Entry Menu (Figure 48 on page 72).
The screens accessible from the **Change in Accounting Method** section include:

- **Screen 3115 (Change in Accounting Method)** — Used to access fields for Form 3115, including Schedules A through D
- **Screen 311E (Schedule E)** — Used to request a change in depreciation or amortization methods
- **Screen ATT (Explanations and Attachments)** — Used to create and view certain attachments to be generated by the software
- **Screen ATT2 (Pt II Ln 12 & Pt III Ln 23b Attachment)** — Used to complete certain parts of Form 3115 that require specific attachments

When you open screen **3115**, the program displays the first of six tabbed screens. As shown in Figure 49, you can access the various **3115** screens by clicking a tabbed link at the top of any of the **3115** screens.

---

**Multi-form Codes**

All **3115** and related screens contain a **Multi-form code** text box (shown in Figure 49) that allows you to link a screen or attachment to a particular Form 3115.

If submitting more than one Form 3115, assign a multi-form code to each new application you create in Drake Tax. The first should be “1,” the second “2,” and so on. When using other screens, such as the **311E** or **ATT** screens, you can use those num-

---

**Figure 48:** Screens for Form 3115, Application for Change in Accounting Method

**Figure 49:** Tab links on 3115 screen
bers to indicate which instance of Form 3115 the 311E or ATT screen should be associated with.

**NOTE**  
If only one Form 3115 is being submitted, you do not need to enter anything in the Multi-form code box.

**TIP**  
See Screen Help (accessible from the 3115 screen toolbar, from the right-click menu, or by pressing CTRL+ATL+?) to access links to Revenue Procedures 2015-13, 2015-14, and 2015-20 through the IRS website.

**Notices of Missing Attachments**  
In addition to Form 3115 and related schedules and statements, the program produces EF Messages (as applicable) when the return is calculated. All forms, schedules, EF Messages, and worksheets are accessible from View mode.

EF Messages for Form 3115 provide information about required attachments (including PDF attachments) that are missing from the return. Some messages list all statements required for a particular section but do not indicate which statements, specifically, are missing. To best understand which attachments are still required, compare the ATT screen and the “EF PDF” worksheet in View mode to the list on the EF Message.

**NOTE**  
All EF Messages must be eliminated before the return is eligible for e-file. EF Messages for Form 3115 attachments are eliminated when all required statements have been attached to the return.

**EF “ACK” Page**  
Similar to federal Form 9325, Acknowledgment and General Information for Taxpayers who File Returns Electronically, generated with 1040 returns, the federal and state Partnership packages now generate an “EF_ACK” page for the main forms of federal returns and “(ST)EF_ACK” page for the main forms of state returns.

This is a Drake Tax-generated form that serves the same purpose as Form 9325: an acknowledgment that a return has been transmitted through Drake Tax and received by the IRS or the applicable state agency.

When a return is e-filed and you receive a “P” ack (indicating that the return is being processed) or an “R” ack (for a rejected return), the top section of the EF ACK page is completed, noting the name and address of the client, the return type, the ERO who transmitted the return), and a check box indicating the return was received by the IRS or applicable state agency.

When the return has been accepted—when you download and process your acknowledgments and receive an “A” ack—the second section of the EF ACK is generated, indicating the return was accepted by the IRS or state agency and the date the return was accepted. The submission ID number is also included.
This page intentionally left blank.
Appendix A: Trial Balance Import

The trial balance import allows data to be imported into a partnership tax return from a trial balance worksheet.

Drake’s specially designed trial balance template and importing function has the following benefits:

• Eliminates the need to duplicate entries
• Eliminates data entry errors by automatically importing data to the correct fields
• Allows preparers to merge basic accounting functions with tax preparation

See the next page for a flow chart describing the use of the trial balance import.
Trial Balance Import: General Process

**Prepare to use Trial Balance Import**
- Enable Excel macros
- Disable autobalance
- Force Schedule L
- Delete unnecessary detail worksheets

**Populate Trial Balance Template**
(Import > Trial Balance Import)
- direct entry data (cells with $0)
- applicable detail worksheets
- totals for:
  - depreciation
  - Schedule L
  - rentals (1120S & 1065 only)

**Populate Data Entry**
Enter any trial balance data that cannot be imported via Trial Balance Import
- Screen SCH2 for Schedule L items
- Screen 4562 for individual assets (depreciation)

**990, 990-EZ, or 990-PF return?**

**Compare M-1, line 1: Does trial balance match Schedule M-1, line 1?**
- **YES**
  - 1120 return? (1120S & 1065)
    - **YES**: Were rental totals entered in trial balance?
      - **YES**: Go to data entry and enter individual rentals on 8825 or RENT screens as applicable
      - **NO**: Delete imported 8825 and RENT screens
    - **NO**
      - **YES**
        - **YES**: Process complete!
        - **NO**
          - **YES**: Make M-1 adjustment
          - **NO**: Adjust amounts elsewhere in data entry

**Compare M-1, line 1: Does trial balance match Schedule M-1, line 1?**
- **NO**
  - **YES**
    - 1120 return?
      - **YES**: Were rental totals entered in trial balance?
        - **YES**: Go to data entry and enter individual rentals on 8825 or RENT screens as applicable
        - **NO**: Delete imported 8825 and RENT screens
      - **NO**
        - **YES**
          - **YES**: Process complete!
          - **NO**
            - **YES**
              - Make M-1 adjustment
              - **NO**: Adjust amounts elsewhere in data entry

**Did data import correctly?**
- **NO**
  - Make corrections in TB worksheet

**Is an M-1 adjustment necessary?**
- **YES**
  - Adjust amounts elsewhere in data entry
- **NO**
  - Make M-1 adjustment

**Process complete!**
Index

Numerics
52-53-week year returns 57

A
counting method
changing 58, 71
entering on 1065 14
accrual (accounting method) 14
address
change of 14
entering on Form 1065 12
foreign 36
on K-1 letter heading 41
out-of-state 28
adjusted basis worksheet 37, 39, 55
adjustments
depreciation 46
to income and expenses 51
allocations
section 754 39
special (screen SA) 35, 39
amending
a 1065 return 14, 24
and TEFRA audit rules 24
K-1 letters 41
amortization 21, 22, 43
analysis
of capital accounts (Schedule M-2) 44
APPT screen, see Multi-State Apportionment
asterisks (on K-1 codes) 35
attachments
binary 59–61
to Form 3115 71
autobalance 44, 56

B
bad debts 16, 18
bankruptcy returns, e-filing not allowed for 57
basis 39
see also adjusted basis worksheet
book-to-tax differences (Schedule M-1) 45–47
business activity codes 14
cash (accounting method) 14, 18
change
of name or address 14
Change in Accounting Method 71–73
Client Communications Editor (for letters) 41
codes
business activity 14
eq reject 58
K-1 35, 55
miscellaneous (screen 1) 28
multi-form 49, 72
compensation of partners 16
contact information (for state returns) 26
control number 10
cost of goods sold, see Schedule A (Cost of Goods Sold)
cover letters (K-1) 40
coversheets 56
credits 16, 22, 51
Ctrl+W (detail) worksheets 14, 15, 16, 63

data entry
for state information 26
importing trial balance into 62–71
state tabs in 26
dates
business start 14
tax year 12
deductions 16–22, 40
depletion 21
oil and gas 11, 32
depreciation
entering 19–21
for cost of goods sold (Schedule A) 15
of rentals 19, 48
on short-year returns 14
printing Form 4562 55
trial balance (business returns only) 69
detail (Ctrl+W) worksheets 14, 15, 16, 63
domestic production activities deduction 40
due dates 22

E
EF_ACK page 73
e-filing 56–57
Form 8879-PE 23
Elections
  Safe Harbor 54
electronic signatures (PIN) 23
employee benefit plans 21
envelope coversheets 56
error codes 58
expenses 16–22
exporting K-1 data 36
extensions 22, 56

F
farm profit or loss 16
filing instructions 56
final return 14
fiscal year returns 12
force print
  end-of-year totals 43
foreign
  addresses for partners 36
  ownership 25
  tab 11
Form 3115 (Application for Change in Accounting Method) 58, 71–73
Form 4562 (Depreciation and Amortization) 49, 55
Form 4797 (Sales of Business Property) 16
Form 5884 (Work Opportunity Credit) 52
Form 6478 (Biofuel Producer Credit) 16, 52
Form 6765 (Credit for Increasing Research Activities) 22, 52
Form 7004 (Application for Automatic Extension of Time to File) 22
Form 8082 (Notice of Inconsistent Treatment or Amended Return) 24
Form 8820 (Orphan Drug Credit) 22, 52
Form 8825 (Rental Real Estate Income and Expenses of a Partnership or an S Corporation) 48–51
Form 8825 (Rental Real Estate) 50
Form 8844 (Empowerment Zone Employment Credit) 52
Form 8845 (Indian Employment Credit) 52
Form 8846 (Credit for Employer Social Security and Medicare Taxes Paid on Certain Employee Tips) 18, 52
Form 8864 (Biodiesel Fuels Credit) 16, 52
Form 8873 (Extraterritorial Income Exclusion) 22
Form 8879-PE (IRS e-file Signature Authorization for Form 1065) 23
Form 8881 (Credit for Small Employer Pension Plan Startup Costs) 52
Form 8893 (Election of Partnership Level Tax Treatment) 55
Form 8903 (Domestic Production Activities Deduction) 40
Form 8912 (Credit to Holders of Tax Bonds) 52
Form 8912 (Credit to Holders of Tax Credit Bonds) 52
Form 8916A (Supplemental Attachment to Schedule M-3) 48
Form 8941 (Credit for Small Employer Health Insurance Premiums) 52
Form 8941 (Credit for Small Employer Health-Insurance Premiums) 22
Form T (Forest Activities Schedules) 21

G
gains and losses 15, 16
grid data entry 34
gross receipts 14
guaranteed payments 17

H
header information 12
health insurance 22
health savings account (HSA) 18

I
importing trial balance 62–71
inactive returns 58
income 14–16
instructions for filing 56
insurance
  and contributions to benefit plans 21
  proceeds, income from 16
interest
  expense 18
  income 16
  ownership of (Schedule B) 24–26
inventory (on Schedule A, Cost of Goods Sold) 15
IRAs 21
Item M (on Schedule K-1) 38

K
K-1 export 36
K-1, Schedule for 1065 33–38

L
letters (K-1) 40

M
M, item (on Schedule K-1) 38
M-3 42
maintenance costs 18
medical care for employees 22
Multi-State Apportionment 27
N
  name change 14
  name control reject 58
  net
    farm profit or loss 16
    gain or loss 16
  next-year depreciation listing 55
  number of partners 14

O
  oil and gas depletion 11, 32
  ordinary gains and losses 15, 16
  other
    costs (Schedule A) 15
    deductions 22
    income (loss) 16
  overrides
    of calculations for partners 35
    on screen 1 28
  ownership
    changes 36
    of interest (Schedule B) 24

P
  partners
    compensation of 16
    foreign addresses for 36
    guaranteed payments to 17
    health insurance 17
    number of 14
    returns with numerous 35
    rounding 34
    Schedule K-1 33
  special allocations for 39
  updating data annually 39
  partnership, termination of 13
  payments, guaranteed 17
  PIN (electronic) signatures 23
  printing
    1065 returns 54
    adjusted basis worksheets 55
    cover letter for K-1 40, 41
    force 54
    Form 8903 for each partner 40
    K-1 items 35
    suppressing/forcing documents 54
  prior-year returns, updating 12

R
  real estate 69
  receipts 14
  refunds, state 16
  reject codes 58
  rent paid on business property 18
  rental activities 48–51
  repair costs 18
  resident state 26, 28
  retirement plans 21
  returns
    52-53-week year 57
    bankruptcy 57
    extensions for 22
    fiscal and calendar year 12
    inactive 58
    short-year 13
    signing 23
    updating prior-year 12
  rounding partner 34
  royalties worksheet 51

S
  SA screen 30
  Safe Harbor Elections 54
  scanning attachments for e-filing 59
  Schedule A (Cost of Goods Sold) 15
  Schedule B (Other Information) 24
  Schedule K (Partners’ Distributive Share Items) 29
  Schedule K-1
    grid data entry 34
    Partner Information 33–38
    sorting 10
    Supplemental information 38
  Schedule L (Balance Sheet per Books) 41–44, 55
  Schedule M-1
    adjustments 44
    Reconciliation of Books 45
    Reconciliation of Books With Return 55
  Schedule M-2 (Analysis of Capital Accounts) 44
  Schedule M-3 (Net Income (Loss) Reconciliation) 47
  section
    179 21, 39
    481 16
    754 20, 39
  security
    business packages 9
    security screen 9
  self-employment income 51
  SEP or SIMPLE plans 21
  short-year returns 13
  signatures, electronic 23
  sorting
    control number 10
    Schedules K-1 10
  special allocations 30
special allocations (screen SA) 35, 39
state
  overriding information related to 28
  resident 26
  tabs in data entry 26
  tax refunds 16
state-specific information 26

T
tax
  years (fiscal vs calendar) 12
Tax Equity and Fiscal Responsibility Act (TEFRA) 24
Tax Matters Partner 25
taxes and licenses 18
technical termination 13
termination of partnership 13
trial balance import
  and depreciation 15
  and SCH2 screens 44
  instructions for using 62–71

U
updating
  a prior-year return 12
  partner data annually 39

W
wages 16

Y
Year screen 13